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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications.

This Concepts and Procedures guide provides information and instructions to help 
you work effectively with Oracle Marketing Online.

This preface explains how this guide is organized and introduces other sources of 
information that may be helpful to you.

Structure

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program web site at 
http://www.oracle.com/accessibility/.

This guide is optimized for online help. It is written in short, self-contained, 
task-oriented topics linked together with hyperlinks. Using this document in 
printed form does not permit you to follow the hyperlinks between topics.

This guide is organized in the following topic groups rather than by chapters:
xi



■ “Understanding Oracle Marketing Online” provides overviews of the 
application and its components, explanations of key concepts, features, and 
functions, as well as the relationship of the application to other Oracle or 
third-party applications.

■ “Using Oracle Marketing Online” provides process-oriented, task-based 
procedures for using the application to perform essential business tasks. 

■ “Administering Oracle Marketing Online" provides task-based procedures for 
required for ongoing application maintenance.

■ @@@“Implementing Oracle Marketing Online” provides general descriptions of 
the setup and configuration tasks required to implement the application 
successfully.

Intended Audience
The Understanding and Using topic groups of this guide are aimed at the following 
users:

■ All marketers using the application

■ Marketing application administrators

The Administering topic group is aimed at:

■ Power users of the application

■ Marketing application administrators

@@@The Implementing topic group is to be used by experienced system 
administrators and Oracle implementation consultants who understand Oracle ERP 
applications only. 

Related Documentation and Resources
The following documents are useful for implementing Oracle Marketing Online:

Note: You should be an experienced system administrator and 
have a good understanding of Oracle ERP applications before 
continuing with the procedures in the Implementing topic group.
xii



Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. This guide 
introduces the concepts behind and major issues for applications-wide features such 
as Business Intelligence (BIS), languages, character sets, and self-service 
applications. It also describes Forms-based and HTML-based products. 

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage processing. It also includes information 
relevant to integrating Oracle Marketing Online with Oracle Web Discoverer. 

Oracle Pricing User’s Guide
Implementers will need this guide to set up pricing features of the Oracle Marketing 
Online.

Oracle System Administrator’s Guide
The Implementation Appendix of this guide gives valuable information on 
implementing Oracle applications.

Implementing CRM Applications Release 11i
This guide outlines the steps required for implementing the Oracle Marketing 
Encyclopedia System. 

CRM Foundation Implementation Guide
This guide outlines the steps required to implement the foundation components of 
the CRM suite of applications.

Oracle Inventory User's Guide
This guide outlines the implementation steps required to set up Oracle Inventory.

Discoverer 3i Installation & Administration Guide Release 3.3 for the 
Web 
This guide outlines the implementation steps for Oracle Web Discoverer.
xiii



BIS11i Implementation Guide 
This guide outlines the steps required to create the End User Layer (EUL) and 
import EUL Export File (EEX) for Oracle Web Discoverer. 
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Understanding Oracle Marketing Online

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the relationship of 
the application to other Oracle or third-party applications.

Overview
Oracle Marketing Online is a database product designed to provide planning, 
tracking, analysis and reporting on an organization’s marketing activities. Its  
functionality is organized by the following tabs:

■ Home: Use this tab to access your most recent work and tasks.

■ Message: This is where you create messages which can be attached to a variety 
of marketing objects.

■ Product: Create products and product bundles in inventory. Create price lists 
and add new items and prices to existing ones.

■ Partner: Use this Oracle Partner Relationship Management functionality to 
track information about partner organizations. For more information see Partner 
Relationship Management Concepts and Procedures.

■ Audience: Create and manage lists and segments of customers and prospects 
for your marketing activities. Use the Organization and Person subtabs to view 
details about your customers using functionality from Oracle Sales Online. See 
Oracle Sales Online Concepts and Procedures for further information.

■ Campaign: Organize campaigns and track related tasks, assignments, activities, 
creative material, and other elements designed to promote or sell concepts, 
products, and services.
Understanding Oracle Marketing Online 1



Navigating Through Oracle Marketing Online
■ Event: Set up and track trade shows, product launches, seminars, and other 
activities associated with a location or locations.

■ Deliverable: Track and manage creative materials associated with campaigns, 
events and organizations.

■ Encyclopedia: Oracle Marketing Encyclopedia provides a media channel for 
coworkers, partners and customers. See Oracle Marketing Encyclopedia Concepts 
and Procedures.

■ Budget: Track, manage and control funding for campaigns, events and 
deliverables. Features a budget checkbook for reviewing expenditures.

■ Claim: Claims and offsets against invoices issued to resellers are tracked and 
resolved using claims.

■ Administration: Configure Oracle Marketing Online.

Navigating Through Oracle Marketing Online
Navigate through the application by clicking on the tabs, subtabs, bins, and side 
panel menu items. Here are the various user interface elements used in Oracle 
Marketing Online and a brief explanation of their use. Click the element name in the 
first column of the following table to see a more detailed explanation.

Tabs, Subtabs and Links
There are two types of page arrangements in the Oracle Marketing Online 
application: 

Interface Element Brief Explanation

Tabs, Subtabs and Links Two levels of tabs provide navigation 
through the application. Some subtabs 
may provide a horizontal list of links.

Side Panel Menus Contain a list of items pertinent to the 
Tab or Subtab. Items which contain 
data may be marked with a checkmark.

Folders Display the hierarchical structure of 
information. Folders which contain 
information are marked with a plus (+) 
sign.

Bins Provide shortcuts to recently-visited 
marketing objects from the Home tab.
2 Oracle Marketing Online Concepts and Procedures



Navigating Through Oracle Marketing Online
■ Pages with two levels of tabs and a side panel menu

■ Pages with two levels of tabs and links

Pages with Two Levels of Tabs and a Side Panel Menu
The Oracle Marketing Online application screen is displayed with a row of tabs 
across the screen directly above a solid band of color, just as file folder tabs would 
appear in a filing drawer. Each tab controls access to a particular object, such as a 
campaign, event, deliverable, or message.

Each tab may have one or more subtabs. These subtabs appear as links on the solid 
band of color. Selecting a link will display the page associated with that subtab.

Subtabs may have a Side Panel Menu. Side Panel Menus contain items which 
display various pages relating to the subtab. Clicking a Side Panel Menu item will 
display the appropriate page.

Pages with Two Levels of Tabs and Links
The Oracle Marketing Online application screen is displayed with a row of tabs 
across the screen directly above a solid band of color, just as file folder tabs would 
appear in a filing drawer. Each tab controls access to a particular object, such as a 
campaign, event, deliverable, or message.

Each tab may have one or more subtabs. These subtabs appear as links on the solid 
band of color. Selecting a link will display the page associated with that subtab.

Subtabs may have an additional row of links running across the top of the screen. 
Clicking a link will display the page for that information.

Side Panel Menus
A Side Panel Menu organizes the information your team enters and tracks. Each 
item on the Side Panel Menu represents a specific collection of information. That 
information is added, modified or removed by selecting the appropriate Side Panel 
Menu item to display the appropriate page.

A checkmark displayed to the left of a Side Panel Menu item indicates information 
has been entered.

All Side Panel Menus, except those associated with Campaigns and Events, have a 
standard list of items. The campaign and event tabs have customizable Side Panel 
Menus which may display different items depending on the type of campaign or 
event.
Understanding Oracle Marketing Online 3



How This Help System Represents Navigation Paths
Folders
Oracle Marketing Online uses folders to display the parent-child relationship 
between marketing objects.

Parent objects, such as summary metrics and costs, are indicated by a plus sign 
displayed just to left of the object name. Only parent objects with child objects are 
shown with plus signs. Clicking on the plus sign displays a list of child objects in 
indented fashion directly below the parent object.

Bins
Bins are displayed on the Home page.  There are bins for Budgets, Campaigns, 
Deliverables and Events. The budget bin displays fixed numerical information 
about your budgets while Campaign, Deliverable and Event bins display links to go 
directly to recently accessed campaigns, deliverables or events.

How This Help System Represents Navigation Paths
Here is the convention used by this documentation to describe user navigation:

■ Tab > subtab > link

■ Tab > subtab > side panel menu item

■ Tab > Create.  Select the tab and click the Create button to create a new 
marketing object for that tab.

Home Page
The Home Page is the first page displayed after logging into Marketing Online. This 
page displays a number of bins for viewing your budgets and for linking directly to 
your most recently accessed campaigns, deliverables and events.

Logging In
In order for you to log in to Oracle Marketing Online, you will need a login id and a 
password. Enter your login and password to access the system and display the 
home page.
4 Oracle Marketing Online Concepts and Procedures



Marketing Campaigns
Responsibilities
Access to many of the tabs is controlled by a responsibility. Each user is given a 
responsibility which determines what tabs are displayed and what rights a user 
may have.

Profiles
Oracle Marketing Online has some attributes that may be modified by the user. The 
profile link in the upper right corner of the page displays a profile page where items 
such as passwords, number of database rows displayed, default currency and other 
attributes.

Getting Help
From any tab, click the Help link in the upper right corner of the screen to display a 
help window for that tab. On that help window you will find a basic explanation for 
that tab as well as a number of useful links for subtopics and related topics.

Marketing Campaigns
Campaigns are constructed using two building blocks:

■ Rollup Campaigns

■ Execution Campaigns

Rollup Campaigns 
Rollup campaigns are the parent objects you use to build the campaign hierarchy 
for the organization. Only Rollup campaigns may have child objects. Rollup 
campaigns are objects where marketing budgets are primarily attached. Execution 
campaigns generally derive their budgets from their parent rollup campaigns. 
Depending on the breakdown of the campaign hierarchy within an organization. 
Rollup campaigns may have rollup campaigns as children and those rollup 
campaigns may have child execution campaigns as well.

Execution Campaigns
Execution campaigns are the operating type of campaign. For example, a parent 
rollup type campaign designed to market a particular product may have many 
child execution campaigns. Perhaps one for each type of marketing medium, such 
Understanding Oracle Marketing Online 5



Marketing Campaigns
as print, radio, or television or for each geographic area, such as north, south or 
west.

Execution campaigns may only be child objects. They may not have children or act 
as parent objects. Execution campaigns are always associated with a parent rollup 
campaign. 

See Also
Campaign Hierarchies

Campaigns Naming Conventions

Campaign Hierarchies
Because the campaign hierarchy determines how budgets are utilized and 
information is gathered about performance of campaigns, it should reflect the 
organization’s business structure. 

Consider a multinational company with a global campaign for two products: 
Widget and eWidget. The company has three regional offices for North and South 
America, Asia Pacific, and Europe Africa. The company changes campaigns 
quarterly.

Each product would have a quarterly rollup campaign. Within each product 
quarterly campaign, there might be three regional quarterly rollup campaigns. Each 
one of the regional campaigns might be divided into separate marketing medium 
rollup campaigns. Each marketing medium campaign could then be divided up into 
multiple execution campaigns, one for each specific marketing medium, such as a 
particular magazine or radio station.

Campaign Naming Conventions
An organization should use a naming convention that makes it easy to distinguish 
between campaigns and the time periods during which those campaigns are active. 
All campaigns appear alphabetically on the same list regardless of their position 
within the campaign hierarchy. Maintaining an appropriate naming convention aids 
in keeping campaigns organized and ensuring that information in maintained in the 
correct campaign.

Campaign And Event Approvals
Campaigns and events are approved according to business rules contained in 
Oracle Workflow. These business rules are designed to reflect the organization’s 
6 Oracle Marketing Online Concepts and Procedures



Marketing Campaigns
approval process. Oracle Marketing Online comes with a predefined workflow that 
automatically sends campaigns and events for approval by a designated approver 
when a campaign or event is created. There are two types of approvals:

■ Campaign and event theme approval

■ Campaign and event budget approval

The organization’s application administrators for Oracle Marketing Online will 
enable the approval workflows during the implementation process.

Theme Approval
When you change the status of a campaign or event from New to Planned, Oracle 
Marketing Online sends a request for approval either to the owner of that campaign 
or event, or, if you are the owner, to the person who is listed as your supervisor in 
Oracle Human Resources. The application automatically changes the campaign and 
event status to Submitted for Approval. You receive a notification in your Personal 
Home Page when the owner or your supervisor approves or rejects the campaign or 
event. If the campaign or event is approved, the status changes to Planned. If the 
campaign or event theme is rejected, then the status becomes Denied Theme 
Approval.

Budget Approval
When you change the status of a campaign or an event from Planned to Active, 
Oracle Marketing Online work flow sends out two requests for budget approval:

■ The overall budget amount you enter in the campaign or event details is sent 
for approval either to the owner of that campaign or event, or, if you are the 
owner, to the person who is listed as your supervisor in Oracle Human 
Resources.

■ The specific line item budget requests entered in the Budget item from the side 
panel menu to the respective budget owners. If the budget item comes from a 
rollup campaign rather than a budget, then the person approving the request is 
the owner of that rollup campaign. The campaign status changes to Submitted 
for Budget Approval. You receive a notification in your Personal Home Page if 
the budget owner approves or rejects the campaign. If the budget is approved, 
then the status of the campaign becomes Available. If the budget is denied, then 
the status becomes Denied Budget Approval. 
Understanding Oracle Marketing Online 7



Executing Marketing Activities Through Schedules
Executing Marketing Activities Through Schedules
Schedules set up the actual delivery of the marketing campaign. Schedules 
determine when specific marketing activity is going to take place, what the 
methodology of that activity is, and how the responses will be captured, as well as 
any mailing or calling lists used, cover letters or other content and what 
deliverables, if any, are involved. 

Schedules can be triggered. That is, some threshold must be reached before a 
schedule will be activated. For example, if the response rate in a particular test 
market reaches a given threshold, then campaign schedule for a larger test market is 
activated.

When you create a schedule using the procedure outlined in Scheduling Activities 
for Campaigns and Events, the information about the activity becomes available to 
others in your organization on the dates you specify. A schedule created manually 
has the Trigger check box deselected.

You can also create a schedule automatically by creating a trigger following the 
procedure outlined in Triggering Campaign Actions Automatically. The application 
creates the schedule and executes the action when the condition is satisfied. A 
schedule created by a trigger has the Trigger check box selected. 

Offers
You can use Oracle Marketing Online to set up five different types of offers:

■ Accrual: Used with Trade Management, accrual offers generate an accrual 
account which can be used to offset purchases or for an eventual lump sum 
reimbursement.

■ Lump Sum: Used with Trade Management, lump sum offers are reimbursement 
for marketing activities taken by a merchandiser on the organization’s behalf. 

■ Off Invoice: Off Invoice offers are direct discounts taken at the invoice level. 
These can be single, 10 percent or $10 off an offer of $100 or more; or they can be 
multi-tiered where the amount or percentage off increases with the size of the 
order. Off Invoice offers are used with single product or product families.

■ Order Value: Order Value offers are discounts based on the total value of the 
order. Again, these may be single or multi-tiered.

■ Promotional Goods: This type of offer bundles promotional goods along with 
customer purchases. For example, a customer purchasing an ink-jet printer 
receives a cartridge free of charge.
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Events
Events
This topic gives an overview of event functionality and explains the differences 
between the two building blocks you use to set up and track events: rollup and 
execution events. It covers:

■ Event overview

■ Event building blocks

Event Overview
An event can be a seminar, a class, a product demonstration, or any other activity 
that is location specific. You can create an event as a stand-alone activity or as part 
of a campaign. Using events a marketer can:

■ Track and distribute event information. This includes information about events 
speakers, directions, deliverables, budgets and registration.

■ Set up event prices and payment methods

■ Manage open and restricted registration using rules and lists

■ Integrate with call centers and Web sites to distribute information and to 
facilitate registration

You can use Events to enroll attendees in event offerings. Where applicable, event 
payment can be processed using a credit card or purchase order. You can send 
enrollees event deliverables that includes descriptions, directions, maps, and cover 
letters.

Event Building Blocks
As with campaigns, you use two building blocks to set up and track events:

■ Rollup events: Where general information is entered about an event such as the 
description, costs, deliverables, venue, directions to the event, and, optionally,  
the campaign used to promote the event. A company offering a sales seminar 
worldwide, for example, enters the information common to all the individual 
country sales seminars in a rollup event. This information can then be 
customized for each separate country, location and time using execution events.

■ Execution events: Allow you to customize the general information you entered 
in rollup events to create specific events and to track participation and 
enrollment in each. For example, a country manager of the company offering a 
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sales seminar worldwide creates an execution event for the local seminar with 
its own times, speakers, and costs associated with each specific event.

Budgets
Budgets are the source of funding for marketing campaigns, events, and 
deliverables. Generally, only a few marketing managers within your organization 
will have the permission to create budgets. Marketers may only request funds from 
an existing budgets.

Budget Hierarchies
Budgets also have a hierarchy. Parent budgets may be broken down into child 
budgets. Funding for campaigns or events may come from either parent or child 
budgets. Often, specific child budgets are created for use with specific campaigns or 
events. When funds are requested from a particular budget, the owner of the 
budget must approve the request. If the requestor is also the owner of the budget, 
then no approval is required.

When the budget owner approves a budget request for a campaign or an event, that 
amount is set aside from the budget. It cannot be released unless the campaign or 
event status is set to cancelled.

Actual costs incurred by campaigns, events and other marketing activities are not 
tied directly to budgets so they are not deducted. However, those actual costs may 
be entered into the system for maintenance of the budget checkbook.

Budget Checkbook
The budget checkbook displays key budget indicators such as total, planned, 
available, committed and spent funds on an marketing object basis. 

Deliverables
A deliverable is any type of creative, advertising, or promotional material used in 
support of a campaign or event. Deliverables can be physical, such as a data sheet 
or a logo-bearing pen or electronic, such as a banner ad, video clip, or logo design.
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Messages
A message is a marketing statement or slogan which can be associated with a 
campaign, a product, or an event.

Finding Information
Oracle Marketing Online provides you with three ways to find the information:

■ Select a view of campaigns, events, deliverables, and other objects from their 
respective tabs

■ Use the Quick Find function to search

■ Perform a detailed search using Advanced Search

Views of Marketing Objects
When you click on a tab, Oracle Marketing Online automatically displays all the 
objects appropriate for the tab which are you are able to edit.

By selecting a different view, the database will be requeried. The objects appropriate 
to that new view will be displayed. 

To help you find objects, you can sort the list by clicking on a column heading. Any 
sortable column heading appears as a hyperlink.

If the list of objects is too long, use quick find to locate a particular object.

Use Advanced Search to search for messages, campaigns, deliverables, events, and 
lists. Advanced search cannot be used to locate notes, tasks, or attachments which 
are associated with messages, campaigns, deliverables, etc.

Quick Find
Use Quick Find to locate a marketing object. Quick Find works even if you know 
only part of the name of the campaign, event, or other object which you are looking 
for. 

Use the "%" sign as a wild card. For example, to search for a campaign, select 
Campaigns from the drop down list and enter a partial campaign name. If you enter 
Q1%, for instance, the application returns a list of all campaigns with names that 
begin with Q1.
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Advanced Search
Selecting the Advanced Search link next to the Quick Find allows you to enter a 
wide variety of criteria for your searches. See Using Advanced Search for 
instructions on how to do so.

See Also
Available Campaign Views

Available Views for Campaigns
You can display the following views of campaigns by making a selection from the 
View drop-down list:

■ My campaigns: Campaigns you own or for which you have update privileges. 

■ All campaigns: All campaigns you can view. 

■ My country’s campaigns: Lists all campaigns viewable to you in your country. 
You must set up your home country in the preferences page. 

■ My division’s campaigns: Lists all campaigns viewable to you in the country 
that belong to your division. A division is one level above your country in the 
geographic hierarchy. For example, the Americas division may consist of USA 
and Canada. If you designate the USA as your home country, then this view 
displays all campaigns in the USA and Canada.

■ My team’s campaigns: Lists all campaigns that include you as a team member.

■ Campaign Hierarchy: Displays the campaign hierarchy for your organization 
as a tree.

Who Can See Which Campaigns
Oracle Marketing Online restricts access to campaigns according to the following 
rules:

■ You can only view a confidential campaign if you are its owner or a team 
member. 

■ If you have edit privileges to a campaign, then clicking the campaign name 
hyperlink takes you to the details subtab where you can edit campaign details.

■ If you have view privileges only, then clicking the name hyperlink displays 
campaign information in a report you cannot edit.
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List Types and Templates
Lists can be generated directly or via a template. of two different types using the 
same list creation procedure outlined in Creating a List:

■ List: Lists are generated by querying the database using the specified criteria. 
The list generates a fixed list at a specific point in time, but which can be 
regenerated to get a refreshed list.

■ List Template: List templates store both the current list of customers as well as 
the criteria and query used to generate that list. Each time the template is used 
or copied, the query is rerun against the database. The advantage of a template 
is that you always have the most complete list of everyone in the database who 
matches the specified criteria.

Creating Lists
You can create a list by querying your database, from segments, or from two or 
more existing lists, or a combination of the two methods. 

This topic explains the basic process for creating a list by:

■ Querying your database

■ Combining existing lists

■ Creating lists from multiple sources

Creating a List by Querying Your Database
The simplest form of a list is the one you create by querying your database. 
Creating such a list is a two-step process: 

1. Using Oracle Web Discoverer, a companion application linked to Oracle 
Marketing Online, you create a query, called a workbook.

2. During the list creation process in Oracle Marketing Online, select the 
workbook to use. 

Generate the list to return the records that fit the query criteria.

Using Multiple Lists
You can create a list by combining more than one existing list. There are three 
different ways of combining multiple lists: 
Understanding Oracle Marketing Online 13



Creating Lists
■ Including all the customers or prospects in the lists

■ Using the intersection of one or more lists

■ Excluding the individuals in one or more lists

This method of creating new lists is preferable to creating a fresh list using a 
workbook whenever you want to target prospects or customers in an existing list. 

For example,  you have recently targeted a marketing campaign to a list of males 
over 30 years of age. You now wish to follow up with an upsell offer to those of 
them who earn over $70,000 per year. 

If you create a new list that queries the database for males over 30 in this income 
bracket, the resulting list may contain any new individuals matching this profile 
who have been added since you ran the campaign. You do not want to include these 
new prospects with the upsell offer because they did not receive with your original 
offer. 

Creating a new list based on an intersect of the list you used for your campaign and 
a list of individuals earning over $70,000 per year limits the targets to the 
individuals targeted by your original offer. 

Creating a List from Multiple Sources
Each source is handled sequentially. That is, you start with one source and then:

■ Add the names of the next source to it generating a list with all names; or 

■ Intersect the names the next source with it generating a list with only names 
that appear on BOTH lists; or 

■ Exclude the names of the next source that also appear in the first source 
generating a list with names that appear in the first source, but not in the 
second.

The generated list becomes the source against which the next source in your list is 
added, intersected or excluded. 

To demonstrate this process follow this example:

Source One contains the names: Mary, Joseph, Camile, Jennifer, John, and Sally.

Source Two contains the names: Gretchen, Maurice, Joseph, Ian, and Bridget.

Source Three contains the names: Jennifer, Susan, Mary, David, Ian, Sally, and 
Jacques.

Source Four contains the name: Jennifer.
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Adding Source One to Source Two generates a list containing all the names from 
both sources: Mary, Joseph, Camile, Jennifer, John, Sally, Gretchen, Maurice, Ian, 
and Bridget.

Intersecting Source Three with the list generates a list containing just the names that 
appear in both places: Mary, Jennifer, and Ian.

Excluding Source Four from the list generates a list containing only names which do 
not appear in Source Four: Mary and Ian.

Oracle Marketing Online combines any number of lists and workbooks based on 
the action you select for each source in the order you specify.

About Workbooks, Worksheets, and Oracle Web Discoverer
Oracle Marketing Online includes Oracle Web Discoverer, a separate application 
which non-technical users can create database queries for list creation.

This topic explains a few key terms:

■ Folders, field icons, and the End User Layer (EUL)

■ Worksheets

■ Workbooks

■ Conditions

Folders, Field Icons, and the End User Layer (EUL)
Oracle Web Discoverer’s graphical user interface represents query results as folders 
and field icons. Users move these from left to right to create a complex query 
without having to view the individual table sources.

The folders represent different views of the database. The Contacts OK to email 
folder, for example, lists all of the customers in the database who have indicated 
that they can be emailed. 

The fields represent customer attributes, including name, telephone number, age, 
and so on. 

Oracle Marketing Online application development team has created folders and 
fields in Oracle Web Discoverer that are specific to marketing. Together this is called 
the End-User Layer.
Understanding Oracle Marketing Online 15



Available Mailmerge Fields
Worksheets
The query you create by moving the folders and fields to the right side of the 
window is called a worksheet. It is these individual worksheets that you use in the 
list creation process.

Workbooks
When you save the query, Discoverer automatically creates a workbook for the 
worksheet. In this respect, Discoverer is analogous to Microsoft Excel where each 
sheet is stored in a book. 

If you wish, you can store multiple worksheets in a workbook. But for the purposes 
of Oracle Marketing Online you are better off having just one worksheet per 
workbook.

This is because you select individual worksheets and not workbooks for list 
creation.

Oracle Marketing Online does not distinguish between worksheets and workbooks. 
Both are called by the generic term workbook and both appear in the list of values 
when you add workbooks during list creation. 

Conditions
You can apply a condition to the worksheet to further constrain the query. For 
example, if you wish to create a worksheet that retrieves only the contact and email 
records for one organization, the Global Enterprise organization, then the condition 
you will use is Organization Name = “Global Enterprise”.

See Also
 Creating Workbooks in Discoverer

Available Mailmerge Fields
The following fields are available for use in cover letters depending on which of the 
two seeded queries you select:

Marketing Simple Query:
■ title

■ first_name
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Tasks
■ last_name

■ pin_code

Marketing Detailed Query:
■ title 

■ first_name

■ last_name

■ pin_code

■ inbound_dscript_name

■ inbound_url

■ inbound_email_id

■ inbound_phone_no

■ source_code

■ offer_code

References
■ For information on how to create a mailmerge letter using these fields, see 

Creating a Mailmerge Letter

Attachments
An attachment is a file or URL associated with a marketing object. Attachments 
provide a methodology for maintaining necessary files in inaccessible area.

Notes
Notes are a free form record of information regarding a marketing object. Notes are 
displayed with their type, text, author and date. Notes become a permanent part of 
the object.

Tasks
A task is a to do item associated with a marketing object, such as a campaign, event, 
or deliverable. Tasks can be given priorities and types. Tasks can be assigned to 
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other individuals or teams. Task status is monitored through email alerts and 
Workflow notifications that are managed by Oracle Workflow.
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The Home Tab
Using Oracle Marketing Online

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

The Home Tab
Use the Home tab to read company news, manage your marketing tasks, and gain 
quick access to your recently accessed campaigns, events and deliverables.

Click the links below to obtain help on:

■ Home tab shortcuts

■ View tasks assigned to you

■ Change the priority, status, and due date of your tasks

■ Reassign a task to someone else

Home Tab Shortcuts
The Home tab provides shortcuts to the campaigns, deliverables, and events you 
have accessed most recently. The shortcuts are generated automatically when you 
create or edit a campaign, event or deliverable. This procedure describes the use of 
these shortcuts.

Prerequisites
None

Steps
1. Navigate to the Home > Home subtab.

2. Click on a hyperlink to display the indicated item. 

Guidelines
You can specify the number of recently accessed objects you wish to see by using 
the Profile Preferences.
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Viewing Tasks Assigned to You
Use this procedure to view tasks assigned to you. 

Prerequisites
None

Steps
1. Navigate to the Home > Task subtab.

2. From the View drop-down list select My Tasks.

The list displays tasks assigned to you.

3. The list may be further filtered by selecting a Priority, Status, and/or Object 
type.

4. The list may be sorted by Name, Planned End Date or Object Type by selecting 
the link in the column heading.

Notes
My Tasks displays only tasks assigned to you. To view tasks you create for yourself, 
be sure to assign them to yourself.

See Also
Changing the Priority, Status, and Due Date of Your Task 

Changing the Priority, Status, and/or Due Date of Tasks
You may change the priority, status, and due date of a task assigned to you or to 
others on your team.

Prerequisites
None

Steps
1. Navigate to the Home > Task subtab.

2. Select the My Tasks view to view tasks assigned to you or the All Tasks view to 
view all tasks.
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3. The list may be further filtered by selecting a Priority, Status, and/or Object 
type.

4. The list may be sorted by Name, Planned End Date or Object Type by selecting 
the link in the column heading.

5. Modify the Priority, Type, Status, or Due Date.

6. Click Update.

Reassigning a Task to Another Person
Use this procedure to reassign a task to another person.

Prerequisites
None

Steps
1. Navigate to the Home > Tasks subtab.

2. Click Reassign.

3. Select the task(s) you wish to reassign to another individual by selecting the 
Select check box next to each.

4. In Reassign Task to field, click Go and use the list of values to enter the 
individual’s name.

5. Click Update.

Setting Profile Preferences
Use these procedure to change your profile preferences for the application. This 
includes, the date format you wish to use, the number of shortcuts on your home 
page, and the number of items that appear in the lists of objects on each tab, etc.

Prerequisites
None

Steps
1. Click the Profile link at the top right of the window. The General Preferences 

page is displayed. 
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2. To select a different format for entering dates, make a selection from the Date 
Format drop-down list. 

3. To change the Number of rows the application displays in tables, select a 
different number from the Rows Per Page drop-down list in the Table Display 
section.

4. To change the number of blank rows you can use for entry in a table, select a 
different number in the Blank Rows Per Table Field in the Table Display section.

5. Click Update.

6. Select the Marketing item from the Side Panel Menu.

7. To change the Country, Time Zone or the number of search results rows 
displayed, select a new value from the drop-down list.

8. Click Update.

9. Select the Personal item from the Side Panel Menu to change the User 
information and password. 

10. Click Update.

Using the Message Tab
Use the Message tab to:

■ Remove a message from use

■ View and edit a message

■ Create a message

Removing a Message From Use
Use this procedure to remove a marketing message from use.

Prerequisites
None

Steps
1. Navigate to the Message tab.

2. Deselect the Active check box next to the message you wish to remove from 
use.
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3. Click Update.

The message can no longer be used with marketing objects.

Viewing and Editing a Message
Use this procedure to view and edit a message.

Prerequisites
None

Steps
1. Navigate to the Message tab.

2. Select the link for the desired message. The Message Details page appears.

3. Edit the details as appropriate.

4. Click Update.

Creating a Message
Use this procedure to create a message to be used with marketing objects.

Prerequisites
None

Steps
1. Navigate to the Message tab.

2. Click Create. The Create Message page appears.

3. Enter the message name.

4. In the Effective Dates field, enter the dates this message is available.

5. Select the message type.

6. If desired, change the message owner.

7. Enter a description of the message.

8. Click Create. The Message Details page appears.
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9. Fill in information in the various Side Panel Menu Item pages. Click an item in 
the Side Panel Menu to display the appropriate page. Entering information on 
an item’s page will cause a checkmark to be displayed to the left of the item 
indicating that information has been entered on that page.

Guidelines:
The list below includes all side panel menu items, except General, available for 
messages. The General item is always the basic object information.

■ Attachments 

■ Notes 

■ Products

Using the Product Tab
Use the product tab to manage products and their price lists. You may obtain help 
on: 

■ Searching For a Product or a Product Bundle in Inventory

■ Viewing the Details of an Product or a Product Bundle

■ Creating a Product or a Product Bundle

■ Creating Offers for a Product or a Product Bundle

■ Viewing Offers for a Product or Product Bundle

■ Specifying Products for a Product Bundle

■ Specifying Upsell and Cross Sell and Other Related Items

■ Making Your Product or Product Bundle Available for Inventory Transactions

■ Adding a Product or Product Bundle to Price Lists

■ Modifying a Product or a Product Bundle

■ Displaying a Price List

■ Creating a Price List

■ Modifying a Price List
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Searching For a Product or a Product Bundle in Inventory
Use this procedure to search for a product or product bundle in inventory. For 
performance reasons, only one inventory location may be searched at a time.

Prerequisites
You must know at least one of the inventory locations or the master organization for 
the product or bundle. 

Steps
1. Navigate to Product > Product Search. The Search page appears.

2. Enter the name of the warehousing organization or the master organization for 
the product or product bundle.

3. Enter other optional search parameters. Partial entries may be used in the 
search fields. Use the % sign to indicate unknown characters.

4. Click Search. The Product Search Results window appears listing any products 
or product bundles that meet your search criteria. 

5. To view more details on a product, click on its link.

6. If you need to refine your search further, select Refine Search and modify your 
search criteria. 

Guidelines
Here are details on some of the search terms:

■ Product Type: This is equivalent to User Item Type in Oracle Inventory. See the 
Main Attribute Group section of the Oracle Inventory User’s Guide for more 
information.

■ Product Number: Inventory number.

■ Related to: Product with an established relationship to the product you wish to 
find, such as a cross sell or upsell item. This List of Values displays all products 
associated with the master organization.

■ Relationship Type: Type of relationship you wish to search on. For example, 
upsell or cross sell. You can only enter this field if you have made an entry in 
the Related to field.
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Viewing the Details of a Product or Product Bundle
Use this procedure to display a product or product bundle.

Steps
1. Navigate to the Product tab. The Products subtab displays a list of inventory 

products and bundles created within Oracle Marketing Online. 

2. The list is sortable by clicking on the different column headings and scroll 
through the items in the list using the controls provided.

3. Click on a product link to display or modify the product details.

4. If the desired product is not on the list, select the Product Search subtab and 
search for the product.

Creating a Product or a Product Bundle in Inventory
Use this procedure to create a new product or a new product bundle in Oracle 
Inventory.

The process for creating a product bundle is almost the same as that for creating a 
product. The only difference is that you must add the products to be bundled in the 
Bundling item on the side panel menu after you have created the bundle.

Prerequisites
An understanding of the organization’s inventory practices and inventory 
numbering conventions.

Steps
1. Navigate to Product > Products.

2. Click Create. The Create Product page appears.

3. To create a product, select the Standard radio button.

4. To create a a product bundle, select the Bundled radio button.

5. Enter a name for the product or bundle.

6. Enter an inventory part number for the product or bundle, following your 
organization’s guidelines for creating inventory numbers.

7. Select one of the three radio buttons:

■ Service: Select if the product or bundle is a service.
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■ Serviceable Product: Select if the product or bundle has one or more 
services associated with it. Selecting this option makes it possible for the 
organization to add services to this product via Order Management.

■ Non-Serviceable Product: Select if the product that has no services 
associated with it. 

8. Select a product type. Product types are the item types provided by Oracle with 
Oracle Inventory and any item types created by your organization. 

9. Click Go in the Master Organization field and use the List of Values (LOV) 
select the name of your internal organization in charge of creating products in 
inventory. 

10. Click Go in the Unit of Measurement List of Values (LOV) and select a unit of 
measure for this product or product bundle.

11. If you wish to assign this product to someone else in your organization, then 
click Go in the Unit of Owner field and use the LOV to select another 
individual. 

12. Optionally, select a status. In the current release, status is for informational 
purposes only.

13. Optionally, enter a product description.

14. Enter a date the item is to be available in the Effective Date field.

15. Select one or more of the following check boxes (see Guidelines section for a 
detailed explanation):

■ Orderable.

■ Stockable: Select if the product is to be Transactable.

■ Transactable: Only available for Stockable products.

■ Invoiceable.

■ Shippable.

■ Returnable.

■ Cost Enabled.

16. BOM Allowed: If this item is a product bundle, the BOM (bill of materials) 
option is automatically selected.

17. Click Create.
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The Product Detail page appears displaying a side panel menu for entering 
additional information.

18. If you wish to create offers or associate existing offers to the product or product 
bundle you have created, then follow the procedure in Creating Offers for a 
Product or Product Bundle. Offers are attachable and viewable only under the 
Campaign tab.

Additional information may now be entered by selecting an item from the Side 
Panel Menu.

■ Enter upsell, cross sell, and other related items for this product in Related 
Products.

■ Assign this product to different warehousing organizations in Organization 
Assignments.

■ Attach documents to the product in Attachments.

■ Enter notes on the product in Notes.

Guidelines
Oracle Marketing Online gives access to the basic features of Oracle Inventory. 
Depending on your business practices, an organization may have to set up further 
details for the product or bundle in Oracle Inventory before the product can be 
manufactured and shipped to customers. These guidelines explain some of the 
Oracle Inventory terminology used. For a more complete explanation, see Oracle 
Inventory documentation.

■ Product Type: This is equivalent to User Item Type in Oracle Inventory. See the 
Main Attribute Group section of the Oracle Inventory User’s Guide.

■ Master Organization: Item Master Organization in Oracle Inventory. This is the 
internal organization that defines items in inventory.

The check boxes on the right of the window turn different Oracle Inventory 
attributes on and off. See Chapter 5 of the Oracle Inventory User’s Guide for further 
information on inventory attributes.

■ Orderable: Selecting this check box sets Customer Ordered on and Customer 
Orders Enabled off. This enables pricing for the item but prevents the item from 
being ordered by external customers. Before the item can be ordered by external 
customers, your organization must use Oracle Inventory to set Customer 
Orders Enabled on.
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■ Stockable: Selecting Stockable allows a product or bundle to be stocked in 
inventory. Selecting this option enables you to select the Transactable check box.

■ Transactable: Selecting Transactable permits inventory transactions for the item. 
You can only select this check box if you have selected Stockable.

■ Invoiceable: Selecting this check box sets Invoiceable Item on and Invoice 
Enabled off. The on value of Invoiceable Item means that this item is activated 
for invoicing and appears in the Invoice Entry item list of values in Oracle 
Receivables.

■ Shippable: Selecting this check box sets Shippable on, indicating that this item 
may be shipped to customers. This causes the item to be released to Oracle 
Shipping Execution’s Pick Release program.

■ Returnable: Selecting this check box sets Returnable on, allowing customers to 
return an item. If an item is returnable, it may be entered the Returns window 
in Oracle Order Management. Order Management uses this attribute along with 
Stockable and Transactable to determine which items may be received in 
inventory.

■ Cost Enabled: Turns Costing Enabled on. This tracts item costs. You may want 
to deselect this option to disable costing for reference items, or for invoice only 
(non–stock) items that you never ship and never hold in inventory.

■ BOM Allowed: Turns BOM (Bill of Materials) Allowed on. This allows you to 
define a bill of materials for the item in Inventory, or to assign the item as a 
component on a bill. This option is selected automatically if you are creating a 
bundled product. The Bill of Materials may be completed in Oracle Inventory.

Viewing Offers Associated With a Product or Product Bundle
Use this procedure to view the offers associated with a product or product bundle.

Prerequisites
Navigate to the details page for the desired product or product bundle.

Steps
1. Select the Offers item from the side panel menu. The Product Details -- Offers 

page displays offers associated with the selected product.

2. To create an offer for a product or associate an existing offer with it, follow the 
procedure for Creating and Associating Offers for a Product or Product Bundle.
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Specifying Products for a Product Bundle
Use this procedure to specify the products for a product bundle created within 
Oracle Marketing Online.

Prerequisites
■ The products you wish to bundle must already exist in inventory.

■ The product bundle must exist before adding the list of products.

Steps
1. Navigate to Product > Product > Bundling. The Bundling page displays.

2. For every component of the bundle:

a. In a blank Product Name field, click Go and use the List of Values to enter 
the product.

b. Enter the quantity of the product you wish to include in the bundle.

3. To delete a component from the bundle, select the Remove check box 
corresponding to the item you wish to delete.

4. Click Update. 

Specifying Upsell, and Cross Sell, and Other Related Items for a Product
Use this procedure to specify an upsell, cross sell, substitute, and other related items 
for a product created in Oracle Marketing Online. You can specify any product in 
inventory as a related product whether or not that related product has been created 
in Oracle Marketing Online.

Prerequisites
■ The products you wish to select as related items must already exist in inventory.

■ You must display the details of a product you wish to modify first.

Steps
1. Select the Related Products item from the side panel menu.

The Product Detail - Related Products page appears.

2. For each related item you wish to add:
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a. In a blank Product Name field, click Go and use the List of Values (LOV) to 
pick the item. This LOV includes all products in inventory.

b. From the Relationship Type drop-down list, select the relationship.

c. If the relationship applies in both directions, then select the Reciprocal 
check box. 

If you specify computer model A to be a substitute for computer model B, 
for example, then selecting this check box means that model B is also a 
substitute for model A.

3. To delete a related item, select the Remove check box corresponding to the item 
you wish to delete.

4. Click Update.

Making a Product or Product Bundle Available for Inventory Transactions
Use this procedure to make a product or product bundle available to organizations 
for inventory transactions such as warehouse stocking.

Prerequisites
Navigate to the desired product and display the details page.

Steps
1. Select the Organization Assignments item from the side panel menu.

The Product Detail - Organization Assignments page displays.

2. For each organization:

a. In a blank Organization Name field, click Go and use the List of Values to 
select an organization.

b. Optionally, use the List of Values to pick the unit of measurement.

3. To delete an organization, select the Remove check box corresponding to the 
item you wish to delete.

4. Click Update.

Adding a Product or a Product Bundle to Price Lists
Use this procedure to add a product to one or more existing price lists using the 
Price Lists side panel menu item. 
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Prerequisites
Display the product details page before you can make entries in the Price Lists page.

Steps
1. Select the Price Lists side panel menu item. The Product Detail - Price Lists page 

displays.

2. Add the product to one or more price lists. To select a price list:

a. In a blank Name field, click Go and use the List of Values (LOV) to select  
the price list.

b. Enter the price.

c. Enter the Unit of Measure (UOM) using the LOV.

d. Enter the start date when the price becomes effective.

e. Optionally, enter an end date.

3. Click Update.

Modifying a Product or a Product Bundle
Use this procedure to modify an existing product or product bundle. 

Prerequisites
Only a product or product bundle created within Oracle Marketing Online may be 
modified from within Oracle Marketing Online. 

Display the details of the product or product bundle to be modified.

Steps
1. The following product information may be modified:

■ Product Name.

■ The type of product by selecting one of the following radio buttons: 

* Service: Select to make the product a service.

Note: You can modify only a product or product bundle created 
from within Oracle Marketing Online.
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* Serviceable Product: Select to make the product a product that has one 
or more services associated with it. 

* Non-Serviceable Product: Select to make the product non-serviceable.

■ Product Type. 

■ Product Owner.

■ Status: In the current release, status is for informational purposes only.

■ Product Description.

■ Effective Date: The date the item will be available.

■ You can modify the selection of the inventory option check boxes (see 
Guidelines below for a detailed explanation):

* Orderable.

* Stockable: Select this check box to select Transactable.

* Transactable: This check box is only available if Stockable is selected.

* Invoiceable.

* Shippable.

* Returnable.

* Cost Enabled.

* BOM Allowed: If this item is a product bundle, this option is selected 
automatically.

2. Click Update.

3. To create offers or associate existing offers to the product or the product bundle,  
follow the procedure in Creating Offers for a Product or Product Bundle. 

More information for the product or product bundle may be entered by selecting 
one of the items from the side panel menu.

Guidelines
Oracle Marketing Online gives access to the basic features of Oracle Inventory. 
Depending on its business practices, an organization may require additional 
information to be added in Oracle Inventory before the product or bundle may be 
manufactured and shipped to customers. These guidelines explain some of the 
Oracle Inventory terminology used. For a more complete explanation, see Oracle 
Inventory User’s Guide.
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■ Product Type: This is equivalent to User Item Type in Oracle Inventory. See the 
Main Attribute Group section of the Oracle Inventory User’s Guide.

■ Master Organization: Item Master Organization in Oracle Inventory. This is the 
internal organization that defines items in inventory.

The check boxes on the right of the page select different Oracle Inventory attributes. 
See Chapter 5 of the Oracle Inventory User’s Guide for further information on 
inventory attributes.

■ Orderable: Selecting this check box sets Customer Ordered on and Customer 
Orders Enabled off. This enables pricing for the item but prevents the item from 
being ordered by external customers. Before the item can be ordered by external 
customers, your organization must use Oracle Inventory to set Customer 
Orders Enabled on.

■ Stockable: Selecting Stockable allows a product or bundle to be stocked in 
inventory. Selecting this option enables you to select the Transactable check box.

■ Transactable: Selecting Transactable permits inventory transactions for the item. 
You can only select this check box if you have selected Stockable.

■ Invoiceable: Selecting this check box sets Invoiceable Item on and Invoice 
Enabled off. The on value of Invoiceable Item means that this item is activated 
for invoicing and appears in the Invoice Entry item list of values in Oracle 
Receivables.

■ Shippable: Selecting this check box sets Shippable on, indicating that this item 
may be shipped to customers. This causes the item to be released to Oracle 
Shipping Execution’s Pick Release program.

■ Returnable: Selecting this check box sets Returnable on, allowing customers to 
return an item. If an item is returnable, it may be entered the Returns window 
in Oracle Order Management. Order Management uses this attribute along with 
Stockable and Transactable to determine which items may be received in 
inventory.

■ Cost Enabled: Turns Costing Enabled on. This tracts item costs. You may want 
to deselect this option to disable costing for reference items, or for invoice only 
(non–stock) items that you never ship and never hold in inventory.

■ BOM Allowed: Turns BOM (Bill of Materials) Allowed on. This allows you to 
define a bill of materials for the item in Inventory, or to assign the item as a 
component on a bill. This option is selected automatically if you are creating a 
bundled product. The Bill of Materials may be completed in Oracle Inventory.
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The Price Lists Subtab
Help is available for:

■ Displaying a Price List

■ Creating a Price List

Displaying Price List
Use this procedure to display a price list. 

Prerequisites
None

Steps
1. Navigate to Product > Price Lists.

2. By making a selection from the View drop-down list, you can view all price lists 
or restrict the view to the price lists you have created (My Price Lists).

3. The list may be sortable by selecting one of the links in the column headings.
.

4. To view or modify the details of a price list, select the price list name link and 
follow the procedure for modifying a price list: 

Creating a Price List
Use this procedure to create a price list. 

Prerequisites
None

Steps
1. Navigate to Product > Price Lists.

2. Click Create. The Price List Details window appears.

3. Enter a name for the price list.

4. Select a currency.

5. Select a status. In the current release, status is used for information only.
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6. To assign a different person as the owner of the price list, select that individual 
using the Owner List of Values.

7. Enter a start date when the price list will be available.

8. Optionally, enter an end date and a description.

9. For each product you wish to add to the price list: 

a. Use the Product Number List of Values to select a product by its inventory 
number.

b. Select the unit of measure for the price.

c. Enter a price.

d. Enter the precedence for this price list. The precedence is a number which 
determines the order in which the pricing engine picks the price list in case 
the customer is eligible for two different prices for this product at this 
quantity. The lower the number, the higher the precedence. 

e. If this particular price is valid for a limited time only, enter a start and an 
end date for this price.

10. Click Create.

11. To view a list of all items and prices you have created, click View Report.

Additional information may be added by selecting one of the items on the side 
panel menu.

References
For more information on price lists and pricing, see the Oracle Pricing User’s Guide. 

Modifying an Existing Price List
Use this procedure to add new products and prices or otherwise modify a price list. 

Prerequisites
Only price lists created within Oracle Marketing Online are modifiable within 
Oracle Marketing Online.

Note: You can modify only price lists created within Oracle 
Marketing Online.
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Display the details of the price list you wish to modify

Steps
1. The following pricing information may be modified:

■ Name.

■ Status: In this release, status is for informational purposes only.

■ Currency.

■ Owner.

■ Start Date: The date the price list becomes available.

■ End Date: The date the price list will be withdrawn.

■ Description.

2. To add additional products to the price list:

a. Use the Product Number List of Values to select the product by its 
inventory number.

b. Select the unit of measure.

c. Enter a price.

d. Enter the precedence for this price list. The precedence is a number which 
determines the order in which the pricing engine picks a price list in case 
the customer is eligible for more than one price for this product at this 
quantity. The lower the number, the higher the precedence. 

e. If this particular price is valid for a limited time only, enter a start and an 
end date for this price.

3. To remove a product from this price list, select the Remove check box next to it.

4. Click Update.

The Partner Tab
Use this tab to create partner organizations and partner contacts in your database 
and to send collateral to your partners. To learn about this Partner Relationship 
Management functionality see Oracle Partner Relationship Management Concepts and 
Procedures guide.
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The Audience Tab
Use this tab to create and manage lists and to view information about customers. 

For information on how to create a customer, view organization details, and other 
procedures carried out on the Organization and Person pages, see the Oracle Sales 
Online Concepts and Procedures guide.

Help is available for:

■ Viewing a List

■ Creating a list

■ Importing a list

■ Creating and editing target and market segments

■ Creating a list import mapping template

For an understanding of the audience tab and how it interacts with Oracle Web 
Discoverer see:

■ List Types and Templates

■ Creating Lists

■ Workbooks, Worksheets, and Oracle Web Discoverer

Viewing and Revising a List 
Use this procedure to view and revise a list.

Prerequisites
An existing list.

Steps
1. Navigate to Audience > List. 

2. Select the list to view or edit. The List Details subtab appears.

3. To view a list that has been generated, click the View List Entries hyperlink. 
Only lists with a status of Available are viewable. This indicates that the list has 
been generated.

4. To edit any of the criteria used to generate the list, refer to the procedure for  
Creating a List.
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Creating a List 
Use this procedure to create lists of targets for campaigns and lists of invitees for  
events. Depending on the installation, lists for campaigns in Oracle Marketing 
Online, for telemarketing execution through Oracle TeleSales, for direct mail 
campaigns through third-party mail-merge programs, for iMarketing execution 
over the Web, or for face to face sales through Oracle Sales Online are available in 
Oracle Marketing Online.

Lists may also be created from queries built in Oracle Web Discoverer or from other 
lists. 

Prerequisites
The sources for a list must be created first. Sources include workbooks created in 
Oracle Web Discoverer, segments created in Oracle Marketing Online, or other lists 
previously created.

Steps
1. Navigate to Audience > List.

2. Click Create. The Create List subtab appears.

3. If workbooks are not yet created, create them following the procedure outlined 
in Creating Workbooks in Web Discoverer. 

4. Enter a list name. 

5. From the Type drop-down list, select the type of list you are creating:

a. To schedule a list for immediate execution through a campaign schedule or 
an execution event, select Target. 

A target list queries the database and generates a fixed list of customers or 
prospects. 

Use this list type to invite prospects and customers to an event by 
associating the list with an execution event or to execute email blitzes and 
other marketing activities using the campaign schedule item on the side 
panel menu.

Note: A list is available only for one execution event or one 
campaign schedule.
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b. If the list is for execution via a trigger or will be reused in the future, select 
Template. 

Templates store both the current list of customers as well as the query 
criteria used to generate the list. Every time the template is used or copied, 
the query is run automatically and the list is refreshed from the database. 
This assures that list contains the most up-to-date customers and prospects. 

6. From the Status drop-down list, select a status for the list. See guidelines below 
for more information about list status. 

7. If you know which campaign schedule or execution event will be using the list, 
then:

a. Use the Association Type drop-down list to specify whether this list is 
going to be associated with a campaign schedule or an execution event.

b. In Association, click Go and use the List of Values to select the campaign 
schedule or execution event that will be using this list.

8. Enter an optional description.

9. To create a list from a single workbook or target segment, in the Selection 
Criteria region:

a. Using the Type drop-down list, select whether you are using a workbook or 
a target segment.

b. Use the Name list of values to enter the name of the workbook or target 
segment to use.

10. To create the list from multiple workbooks, target segments, or lists, then, in the 
Selection Criteria region, enter each source element on a separate line:

a. Using the Type drop-down list, select whether the source is a workbook, a 
target segment, or an existing list.

b. Use the Name List of Values to select the name of the source. 

c. Using the Action drop-down list, indicate how the entries in the source are 
to be used in combination with the other lists. Include is the default action 
Action for the first source. 

Note: Once a list is associated with a campaign schedule and 
execution event, the list becomes locked and cannot be used with 
any other campaign schedules or execution events.
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The available actions for the other sources are:

* Include: Include all the entries in the next list or workbook with the 
previous list entries.

* Exclude: Exclude all the entries in the next list or workbook that also 
appear in both the previous and next lists.

* Intersect: Only the entries that appear in both the next list or workbook 
and the previous list or are included.

d. When using more than two sources, use the Order fields to specify the 
order in which the sources are processed. The order specified may have a 
large effect on the final list.

11. In Size Selection, enter information about the maximum size of the list, either as 
an absolute number or as a percentage. Enter one of the following:

■ In the Maximum field, enter the maximum number of records for your list. 
List generation will stop after this number is reached.

■ In the Percent of Rows field, enter a value for the percentage of candidates 
to be picked from among all those eligible. 

12. If the maximum list size as a percentage, was selected in the previous step, enter 
a weight in the % field for each list source you added.

For example, if the first source has a weight of 90%, then 90% of the selections 
will be performed from that list. The percentages for all sources must add up to 
100. 

13. If a maximum size for the list was selected, in the Selection Size region select 
one of the radio buttons corresponding to the desired selection method:

■ Top Down: Starts picking from the top of the list until the maximum size is 
reached.

■ Every Nth Row. Picks possible list entries from every Nth row.

■ Random: Selects entries at random. 

14. To generate a log report on the list generation process, in the List Details region, 
select the Log Reports check box.

15. To remove duplicates at the time the list is generated, the List Details region:

a. Select the Remove Duplicates on Generated List check box.

b. Select the deduplication rule used for the removal by clicking Go in the 
Rule field and using the list of values.
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c. For each source added in the Selection Criteria region, enter a ranking in the 
Rank field. The rank assigned determines which source takes precedence in 
case there is a duplicate. The higher ranked source is the one that supplies 
the entry into the list. 

16. If you wish the duplicate removal process to use a list of words commonly used 
as duplicates, then select the Use Word Replacement check box. For example, a 
word replacement rule can instruct the application to treat Bill as a duplicate of 
William for first names. The word replacement rules are set up by the 
organization’s application administration team. 

17. To create a Target type list, in the List Generation Region:

a. Select the Generate List check box.

b. To generate this list immediately, leave the Scheduled Date and Time Zone 
and Time fields blank. Otherwise, fill in the desired day and time the list 
should be generated.

18. Click Update to save the list details. The List subtab appears.

If the Generate List check box has been selected and the list is scheduled for 
immediate execution, the list Status changes to Available when the list 
generation is complete.

Guidelines
The table below explains the different statuses for lists.
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References
■ About List Types and Templates

■ About Creating Lists

■ About Workbooks, Worksheets, and Oracle Web Discoverer

Viewing Existing Workbooks
Use this procedure to view existing workbooks in Oracle Web Discoverer. 

Prerequisites
An existing workbook.

Steps
1. In the Audience tab, click on an existing list name or click Create. The Create 

List or List Details page displays.

2. Click the Web Discoverer hyperlink at the upper right hand corner of the page.

Field Explanation

Status List status can be set by the user and by the 
application. Here are the values:

New Default status when you create 
a new list.

Pending The status after the list has 
been submitted for generation.

Available A list automatically attains a 
status of available when the list 
generation process completes 
successfully.

Locked The list is being used by a 
campaign. You cannot make 
any modifications.

Expired List is not available for use. 
Your license has expired or the 
list is out of date, for example.

Archived List is not available for use.
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After the Oracle Web Discoverer applet finishes loading, Step 1 of the 
Workbook Wizard displays.

3. Click Open an existing workbook.

4. The question "Where is the workbook you want to open?" appears. 

5. Click Database. Only workbooks stored in the database may be accessed.

6. Oracle Web Discoverer displays a list of existing workbooks.

7. Select a workbook to view.

8. Click Open.

Oracle Web Discoverer automatically executes the workbook query and 
displays the results. 

9. To view or edit the query, click the Edit button on the toolbar. Oracle Web 
Discoverer displays the query. 

10. Workbook or worksheets may be modified using the same procedure outlined 
in Creating WorkBooks in Discoverer.

References
About List Types and Templates

About Creating Lists

About Workbooks, Worksheets, and Oracle Web Discoverer

Creating Workbooks in Oracle Web Discoverer
Oracle Web Discoverer allows you to create queries that can be used to generate 
lists in Oracle Marketing Online without a knowledge of programming or query 
language. Use this procedure to create queries in Oracle Web Discoverer.

Prerequisites
None

Steps
1. In the Audience tab, click on an existing list name or click Create. The Create 

List page appears.
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2. Click the Web Discoverer hyperlink at the upper right hand corner of the page. 
After the Oracle Web Discoverer applet finishes loading, Step 1 of the 
Workbook Wizard appears.

3. Click Create a new workbook.

4. Select the Table radio button.

5. Click Next to move to Step 2 of the wizard.

6. The wizard now displays all the Oracle Marketing Online folders. These contain 
the fields you can use to construct your query. 

7. To view the contents of a folder, click on the plus sign (+) node to the left of the 
folder.

8. Construct your query by moving whole folders or individual fields using the 
right arrow button:

a. Select the folder or field.

b. Click the right arrow button.

When a folder or field becomes grayed out (disabled), this means that the folder 
or field already has been selected.

9. In any query constructed, you must include at least one mandatory field: 
Mandatory Identifier. It can be found in the All Contacts folder.

10. To build a query to create an email blitz, include the following mandatory 
identifiers (see Guidelines for an example):

■ Include Contact Details

■ Include Organizational Details

■ Include Email

11. To use a field as a condition of the query, that field must be included in your 
query as well. For example, if the condition Organization Name = 
"Global Enterprises" is used, then the Organization Name field must be 
selected for your query. 

12. Click Finish. Oracle Web Discoverer executes the query you just created and 
displays the results. 

13. To add a condition to the query:

a. Click the Edit button in the toolbar.

b. Select the Condition tab.
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c. Click New. The New Condition window appears.

d. In the Item field of the Formula region, select the item to be evaluated.

e. Using the Condition drop-down list, select the desired operator.

f. In the Values field, enter the value for comparison.

g. Click OK. The Conditions tab appears displaying the condition you have 
created.

h. Click OK.

14. Click Save on the toolbar (the diskette icon).

Guidelines
Here is a sample query to create a workbook for an email blitz:

Select the following folders and fields to create a workbook that will extract email 
addresses for a mailing list for use in an direct email campaign

From the All Contacts folder select the following:

■ Mandatory Identifier

■ Include Contact Details

■ Include Organization Details

■ Include Email

■ Organization Id

■ Party Id

■ Contact name (optional)

■ Contact phone (optional)

From the Contact Email folder, select the following fields:

■ AMS Contact Email Id

■ Contact Id

■ Email Address

References
■ About List Types and Templates

■ About Creating Lists
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■ About Workbooks, Worksheets, and Oracle Web Discoverer

Importing a List
Use this procedure to import a list or modify an existing import.

Prerequisites
The list to be imported must be located in the directory specified by your 
application administrator.

Steps
1. Navigate to Audience > Import

2. Click Create. The Import List page appears.

3. To modify an existing list import, click on the name of the list to be edited. The 
Import Details page displays.

4. Enter in the import list name.

5. Select the import type as Rented List. Other types are for future releases.

6. Specify other details of the imported list such as the version number, the vendor 
that supplied the list, the cost of purchasing the list, the expiration date, and a 
description.

7. Enter the list import parameters:

a. Enter the file name for the import file.

b. Using the Mapping Template drop-down list, select an import mapping 
template you wish to use to map this file and indicate any number of rows 
to skip. If no mapping template exists, then click Create New to create it 
(see Creating a List Import Mapping Template).

c. Specify how the columns are delimited in the import file and what the 
fields are enclosed with.

d. If a file header exists in the file, select the File Header Exists check box. The 
file header is the first row in the file which contains the field names of the 
imported file.

e. If you wish to have duplicate entries removed from the list, then select the 
De-Duplicate the Import check box.
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f. To import the list into the customer table (TCA), select Perform Post Import 
Processing. The Name and Party ID will be created in TCA for each 
non-duplicate record. 

8. Click Create Control File and then Load to execute the import into the database

9. The list must be generated before it can be used. Generate it by creating a 
Workbook within Oracle Web Discoverer and mapping the source file to the 
Marketing List Generation Table (AMS_LIST_ENTRIES). 

Creating a List Import Mapping Template
Use this procedure to create an import mapping template. The template maps the 
fields of an imported list. This template must be created prior before importing the 
list.

Prerequisites
You must have a system administrator place the file to be imported in the UNIX 
middle tier database.

Steps
1. Navigate to Audience > Import

2. Click Create. The Import Mapping Template page appears.

If the list has a header row, then the Source Field displays the field name, 
otherwise this column displays the first record in the file.

3. Enter a template name.

4. Enter a code.

5. Leave the default destination column fields unless the destination fields cannot 
accommodate the size of the source field. The field sizes may be found in the 
Oracle Marketing Online Technical Reference Manual.

6. Optionally, update the Source Field Meaning. If the list has no header and one 
was specified during list creation, then the application uses a generic column 
reference, for example: COL1, COL2, and so on.

7. To exclude any of the fields from the imported list, deselect the Include check 
box next to that field.

8. Save your work by clicking Create.
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Creating and Editing Target and Market Segments
Use this procedure to create target or market segments or edit existing ones. Target 
or market segments provide a way of organizing the queries you create in Oracle 
Web Discoverer. Target and market segments contain the same data, however, they 
are generally thought of as specific and general, respectively.

Using the Parent Segment field, hierarchies of market segments, called Target 
Groups may be created. These groups may be tracked via Oracle Business 
Intelligence. Each segment has a one to one correlation with an Oracle Web 
Discoverer workbook. 

Prerequisites
Existing workbooks

Steps
1. Navigate to Audience > Segment

2. To create a new segment, click Create. The Create Segment page appears.

3. To edit an existing segment, select the segment name. The Segment Details page 
displays the segment setup.

4. Enter or modify the name for this target or market segment.

5. In Code, enter a unique identifier.

6. Select the type of segment as a target or market segment.

7. Use the parent segment to build a segment hierarchy. 

8. Enter a description for the segment.

9. Select an Oracle Web Discoverer workbook for the segment.

10. Click Update to save. The SQL Viewer displays the SQL code used by the 
workbook.

Managing Customer Information via the Organization and Person Subtabs 
Use the Organization and Person subtabs of the Audience tab to view information 
about customers and enter new customers into the customer table (TCA). See the 
Oracle Sales Online Concepts and Procedures guide for more information.
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The Campaign Tab
Use the Campaign tab to manage your marketing campaigns.

Help is available for:

■ Viewing and editing a campaign

■ Viewing your campaign hierarchy

■ Creating a campaign

■ Copying an existing campaign

For more information see:

■ Campaign hierarchies

■ Campaign naming conventions

Viewing and Editing a Campaign
Use this procedure to view or edit an existing rollup or execution campaign.

Prerequisites
None

Steps
1. Navigate to the Campaign tab.

2. If the desired campaign is not in the list, search for it by changing the View 
Type, or using by QuickFind or Advanced Search.

3. Click the campaign link to view or edit. The campaign details page displays.

Viewing You Campaign Hierarchy
Use this procedure to view a campaign hierarchy.

Prerequisites
None

Steps
1. Navigate to the Campaign tab.
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2. From the View drop-down list, select Campaign Hierarchy. The tab displays the 
hierarchy of the organization’s campaigns.

3. Clicking on a folder with a plus sign reveals campaigns lower in the hierarchy. 

4. Click on a campaign link to view or edit it.

Creating a Campaign
Use this procedure to create a campaign.

Prerequisites
Marketing mediums and campaign types must be set up.

Steps
1. To create a campaign that is similar to an existing campaign, copy that 

campaign and modify it instead of creating a new one. 

2. To create a new campaign, navigate to the Campaign tab and click Create. 

3. To create an element of a campaign hierarchy for reporting and tracking, then 
select the Rollup Campaign radio button and follow the steps in Creating a 
Rollup Campaign. See Understanding Rollup Campaigns.

4. To create a campaign for the specific execution of marketing activity, such as an 
email blitz, a telemarketing campaign, a marketing campaign over the web or 
another marketing activity, select the Execution Campaign radio button and 
follow the steps in Creating an Execution Campaign.

References
Marketing Campaigns

Creating a Rollup Campaign
Use this procedure to create a rollup campaign. A rollup campaign is used to group 
marketing activities tracked by execution campaigns and to build a campaign 
hierarchy for cost tracking, approvals, and reporting.

Prerequisites
Understanding of the organization’s campaign setup
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Steps
1. Navigate to the Campaign tab.

2. Click Create. The Create Campaign page appears.

3. Select the Rollup Campaign radio button. The window refreshes to display 
fields particular to rollup campaigns.

4. Use the Setup Type drop-down list to select the custom setup for the campaign. 
Custom setups determine what side panel menu items are available for the  
campaign. The items that appear on the side panel menu are selected by the 
application administrator.

5. Enter a name for the campaign. Use the naming convention of the organization 
if one is available.

6. To create a top level rollup campaign, leave the Parent field blank. Otherwise, 
use the Parent list of values (LOV) to associate this rollup campaign with a 
rollup campaign above it in the campaign hierarchy. Note the available dates of 
the parent campaign. The available dates for the child campaign must fall 
within the dates of the parent.

7. To limit access to campaign information to the campaign owner and team 
members, then select the Confidential check box.

8. Enter the start and end dates for this campaign. The dates must fall within the 
available dates for the parent campaign, if any.

9. Enter a comment and any other optional information.

10. Leave the Source Code field blank. A unique source code will be generated 
automatically by the application.

11. Click Create. The Campaign Details page appears.

Creating an Execution Campaign
Use this procedure to create an execution campaign. Execution campaigns are 
where campaign activities such as email blitzes and telemarketing campaigns are 
executed.

Prerequisites
None
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Steps
1. Navigate to the Campaign tab

2. Click Create. The Create Campaign page appears.

3. Select the Execution Campaign radio button.

4. Using the Setup Type drop-down list, select a custom setup. Custom setups are 
templates for different types of campaigns created by the organization’s 
application administrator. The window refreshes to display fields appropriate 
to the campaign type selected.

5. Enter a name for the execution campaign. Use the naming convention of the 
organization if one is available.

6. If the campaign is a stand-alone execution campaign, the Parent field may be 
left blank, otherwise you must use the Parent list of values (LOV) to associate 
an execution campaign with a the rollup campaign that is above it in the 
campaign hierarchy. The available dates for the execution campaign must fall 
within the available dates for the rollup campaign.

7. To limit access to campaign information to the campaign owner and team 
members, then select the Confidential check box.

8. Enter the start and end dates for this campaign. The dates must fall within the 
available dates for the parent campaign.

9. Enter the marketing medium for the execution campaign. The marketing 
medium is the channel through which the campaign is delivered. For television 
advertisements, for example, this is the television station used. For a 
telemarketing campaign, this is the call center making the calls. For an email 
campaign, this may be the server handling the emails.

10. Optionally, enter the budget for this campaign by using the drop-down list to 
select the currency and entering the amount. This amount is for information 
only. You must enter the actual amount you are requesting in the Budget item 
on the side panel menu. 

11. Enter a comment and any other optional information.

12. Leave the Source Code field blank. A unique source code is generated 
automatically by the application.

13. Click Create. The window refreshes and the Campaign Details page appears.
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Entering Campaign Details
Use this procedure to enter details for a rollup or an execution campaign.

Prerequisites
An existing campaign.

Steps
1. Navigate to the Campaign Details page of the campaign.

2. All the required fields on this page were filled out when the campaign was 
created. They may be modified now. 

3. If you are requesting funds from budgets for this campaign, then: 

a. From the Budget Amount drop-down list, select the currency. 

b. Enter the amount of your proposed budget for the campaign. If the budget 
approval work flow is enabled for this campaign type, this amount is 
automatically sent to your manager for approval. 

4. Fill out any other optional fields.

5. Click Update. You are now ready to enter information into items on the side 
panel menu associated with the campaign. The items that appear on the side 
panel menu depend on the type of campaign created.

Note: Requesting funds from individual budgets is done entirely 
on the Budgets item on the side panel menu.

Note: Do not modify the source code. It is generated by the 
system.

Note: A check mark next to an item means that some data has 
been entered. It does not mean that all the information has been 
entered.
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Guidelines:
The following table lists all item on the side panel menus and whether these are 
used for rollup campaigns, execution campaigns, or both. Rollup campaigns store 
only basic information about campaigns, so the number of available attributes is 
limited.

Only a subset of these attributes may be listed in the checklist for a campaign. This 
is because different types of campaigns need to track different types of information. 

Budgets and Requesting Funds for Your Marketing Activities
Use this procedure to request funds from a budget or campaign for your marketing 
activities using the Budgets item on the side panel menu. 

Attribute
Used in rollup 
campaigns

Used in 
execution 
campaigns

Attachments Yes Yes

Budgets Yes Yes

Costs Yes Yes

Deliverable Yes Yes

Geography No Yes

Market No Yes

Message Yes Yes

Metrics Yes Yes

Notes Yes Yes

Offer No Yes

Partner No Yes

Products No Yes

Response No Yes

Schedule No Yes

Tasks Yes Yes

Team Yes Yes

Trigger No Yes
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Prerequisites
The budget from which funds are requested from must be approved and have a  
status of active.

Steps
1. Use the Type drop-down list to select the type of source for funds. Most of the 

time the source is a budget, but funds may also be requested from a parent 
rollup campaign.

2. Use the Name list of values (LOV) to select the funding source.

3. In Request Amount, enter the amount you are requesting.

4. Click Update. When the status of a campaign or event changes from Planned to 
Active, Oracle Marketing Online sends a request for approval of the request to 
the budget owner. If the budget for the campaign comes from a rollup 
campaign rather than a budget, then the person approving your request is the 
owner of that rollup campaign. While the funds are pending, the campaign 
status remains Submitted for Budget Approval. 

A notification will be received at your Personal Home Page when the budget or 
campaign owner approves or rejects the campaign. If the budget is approved, 
then the status of the campaign becomes Available. If the budget is denied, then 
the status becomes Denied Budget Approval.

Associating Deliverables to a Campaign or Event
Use this procedure to associate deliverables to campaigns and events using the 
Deliverable item on the side panel menu. A deliverable can be a physical item, such 
as a brochure, or an electronic file. 

Prerequisites
The deliverable must be created first before you can associate it with a campaign or 
event. If the deliverable is a physical object such as a brochure, then the deliverable 
must be an item in Oracle Inventory. If the deliverable is an electronic file, then it 
must be entered it into the database first.

Steps
1. Navigate to the Deliverables item on the side panel menu.

2. If you have not created the deliverable, then click Create Deliverable and 
following the procedure for Creating Deliverables.
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3. Use the Type drop-down list to select a deliverable type.

4. Use the Name list of values (LOV) to select the deliverable to attach to the 
campaign or event.

5. In the Quantity field, enter the number of deliverables needed. To create an 
electronic deliverable such as a design for an advertisement or the text of an 
email sent to prospects, then enter the number 1. A numerical estimate is 
important only if the deliverable includes variable costs such as a printed 
brochure.

6. In Need by, enter the expected delivery date. This date is for informational 
purposes only.

7. Click Update. 

Tracking Costs Using the Costs item on the side panel menu
Use the costs item on the side panel menu to track costs. Use this attribute to:

■ Determine which costs you wish to track

■ Enter costs

Determining Which Costs to Track
Use this procedure to determine which costs to track using the Costs item on the 
side panel menu.

Prerequisites
Cost metrics must be set up before associating them with a campaign.

Steps
1. Navigate to the Costs item on the side panel menu.

2. Select the Detailed radio button.

The available cost metrics appear in the Costs region.

3. Add additional cost metrics in the Create New region: 

a. In the Name field, click Go and use the list of values to select the cost 
metric.

b. Click Update.
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Entering Costs
Use this procedure to enter the costs of campaigns, events, and other objects in the 
Costs item on the side panel menu.

Prerequisites
Cost metrics must be set up before associating them with a campaign.

Steps
1. Navigate to the Costs item on the side panel menu.

2. Select the Input Only radio button.

The Costs region displays the cost metrics associated with the campaign. 

3. Enter the costs:

a. Using the Currency drop-down list, select the currency.

b. In the Actual column, enter the cost amount rounded to the nearest 
currency unit. Any fractions are rounded automatically.

c. Optionally, enter a forecast amount.

d. Click Update.

Metrics item on the side panel menu
Use the metrics item on the side panel menu to:

■ Determine which metrics to use

■ Enter values into the metrics

Determining Which Metrics to Use
Use this procedure to associate metrics with a campaign, event, offer, or other object 
within Oracle Marketing Online.

Prerequisites
Metrics must be created before associating them with a campaign or other object.

Steps
1. Navigate to the Metrics item on the side panel menu.
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2. Select the Detailed radio button.

The available metrics, if any, appear in the Metrics region.

3. Add additional metrics in the Create New region:

a. In the Name field, click Go and use the list of values to select the metric.

b. Click Create.

Entering Values into Metrics 
Use this procedure to enter values into metrics that allow manual entries. 

Prerequisites
Metrics must be created before associating them with a campaign or other object. 
Values may only be entered into metrics that allow manual entries.

Steps
1. Navigate to the Metrics item on the side panel menu.

2. Select the Input Only radio button. The screen refreshes and displays the 
metrics associated with the associated object. If the Metrics section does not 
appear, this means that there are no associated metrics which allow manual 
entry.

3. Enter metric values in the Actual and Forecast columns. 

4. Click Create.

Entering and Viewing Notes
Use this procedure to enter or view notes about an Oracle Marketing Online object 
such as a campaign, an event, a budget, or a message.

Prerequisites
None

Steps
1. Navigate to the Campaign Details page.

2. Click on the Notes item on the side panel menu. The Campaign Details - Notes 
page appears.
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3. Notes may be viewed at the bottom of the page under the Note History 
heading.

4. To enter a note:

a. Select an optional Note Type.

b. Enter the note.

c. Click Create.

Guidelines
Notes may be viewed from the campaign, event, or other object where they were 
created only. They cannot be viewed from other objects. Only team member can 
view notes.

The Tasks item on the side panel menu
Use Tasks to:

■ View tasks associated with the campaign, event or other object

■ Assign tasks

Viewing Tasks Assigned to a Specific Campaign or Other Object
Use this procedure to view the assigned tasks for a campaign, event, or other object.

To view only the tasks assigned to you, navigate to Home > Tasks. 

Prerequisites
None

Steps
1. Navigate to the Tasks item on the side panel menu.

2. The page displays the tasks related to this object.

3. Tasks may be sorted by priority or status using the drop-down lists or sort them 
by clicking on the column heading links for Name and Planned End Date.
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Creating and Assigning Tasks for Specific Marketing Activities
Use this procedure to assign tasks for a specific marketing activity. The task will be   
linked to the specific activity where it was created. For example, create a task while 
editing an event and that task will be linked to that event.

Prerequisites
None

Steps
1. Navigate to the Tasks item on the side panel menu.

2. Click Create. The Create Tasks page appears.

3. In the Name field, enter a few words describing the task. This is similar to the 
subject line of an email. The task will be explained in further detail elsewhere.

4. If desired, classify the task with Type, Priority, and Status. 

5. In Planned End Date, enter a due date for the task.

6. In Assignee, click Go and use the list of values to enter that name of the person 
to whom the task is assigned.

7. Click Create.

8. Click on the task name to add a detailed description of the task and other 
details.

Adding a Description of a Task and Editing Task Details
Use this procedure to add a description and other details to a task.

Prerequisites
An existing task.

Steps
1. Navigate to the Update Tasks page. Reach this by clicking on a task name in the 

list of tasks, on the home page. 

2. Enter a detailed description explaining the task in the Notes text box. 

3. To keep this task private so it is not visible to others in your team, select the 
Private check box.
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4. Edit other fields.

5. Click Update. 

 Attaching Files
Use this procedure to save a file in the database and attach it to a campaign, event, a 
deliverable, or other object. An attachment can be a file of any size and type.

Prerequisites
None

Steps
1. Click on the Attachments item on the side panel menu.

2. In an available row, click Go next to the Name field. The Attachment Selection 
dialog appears.

3. Click Browse and select the file to enter into the database.

4. Click Submit. If the file is large, this may take a few minutes.

5. Using the Type drop-down list, select the File type.

6. Click Update. The file name will turn into a hyperlink indicating that the 
attachment has been created.

Granting Others the Right to Edit Using the Team Attribute
Use this procedure to grant individuals or whole teams the right to edit campaigns, 
events, budgets, or price lists or other objects, by adding their names in the Team 
item on the side panel menu.

Prerequisites
None

Note: Individuals to whom editing rights are not granted may 
view a summary of objects in the application displayed in their 
browsers, but they cannot view details such as notes and tasks and 
cannot make any changes. 
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Steps
1. Navigate to the Team item on the side panel menu. The Team page appears.

2. To grant editing privileges to an individual, select the user from the User/Role 
drop-down list.

3. To grant edit privileges to a whole team, select the team from the User/Role 
drop-down list.

4. Use the Name list of values (LOV) to enter the name of the person or team.

5. If the individual or team is to have permission to edit metrics of this campaign, 
then select the Metrics check box.

6. Click Update.

Specifying a Market Segment
Use this procedure to specify the market segment you wish to target with your 
campaign, event, offer, product, or budget. This is for informational purposes only. 
Market segments selected here do not trigger any seeded Oracle Marketing Online 
workflows.

Prerequisites
The market segments must already be created using Oracle Web Discoverer.

Steps
1. Navigate to the Market item on the side panel menu. The Market page appears.

2. From the Type drop-down list, select the segment type.

3. In Segment Name, click Go and use the list of values to enter the segment. 

4.  Click Update.

Attaching a Marketing Message to Your Campaign or Event
Use this procedure to attach a marketing message to a campaign or event. Attaching 
a marketing message is another way of classifying campaigns.

Prerequisites
The marketing message must be created it can be attached to a campaign or event.
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Steps
1. Navigate to the Message item on the side panel menu. The Message page  

appears.

2. From the Message Type drop-down list, select the message type to use.

3. Use the Message list of values (LOV) to select the name of the message.

4. Click Update.

Scheduling Activities for Campaigns and Events
Use this procedure to schedule a campaign activity such as an email blitz or the 
telemarketing of a particular segment of the audience. Multiple schedules may be 
created for each campaign. 

To start an activity automatically when a specific condition becomes true, create a 
trigger. When the condition becomes true, the trigger automatically creates a 
schedule for the activity and executes it. 

Prerequisites
An existing campaign and available marketing mediums.

Steps
1. Navigate to the Campaign Details page.

2. Click on the Schedules item on the side panel menu. The Campaign Details - 
Schedule page appears.

3. Enter the range of dates for the activity scheduled. The date range must fall 
within the dates for the campaign. These are displayed at the top of the page.

4. Do not make an entry in the Source Code field. The application generates the 
unique identifier for the activity automatically.

5. Click Setup. The Schedule Details page appears.

References
Executing Marketing Activities Through Schedules

Entering Details About a Campaign Schedule
Use this procedure to enter or edit information in a schedule.
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Prerequisites
An existing campaign schedule.

Steps
1. Navigate to the Schedule Details page of a campaign. The page displays  

automatically when a schedule is created. Or reach it by clicking on the 
Schedule item on the side panel menu from the Details page of a campaign and 
selecting a schedule.

2. To modify the dates of a schedule, change the start and end dates. The dates 
must still fall within the effective dates of the campaign.

3. To make a deliverable, such product collateral, available for the marketing 
activity, select that deliverable using the Deliverable drop-down list.

4. To make an offer available through the campaign, select the offer using the 
Offer drop-down list. The offers that appear on this list are limited to the offers  
associated with the campaign in the Offers item on the side panel menu.

5. If the activity involves an outbound calling campaign and the call center needs  
a script, click Go in the Script field and use the list of values (LOV) to select a 
script. Scripts are created using Oracle Scripting, a separate application.

6. To specify the text of the email merge letter to be sent out to your customers:

a. In the Cover Letter field click Go and use the LOV to specify the merge 
letter. 

b. To specify the text of the subject line of the email, enter it in the Subject text 
field.

c. Enter the email address for the sender of the email.

d. If customers should reply to a different person than the sender, enter that 
email address in the Reply To text field. 

7. In the Response region, enter information on where customers can go for more 
information: 

a. To publish a URL where customers can obtain more information, enter that 
URL.

b. To give your customers an email address where they can obtain more 
information, then enter the address in the Email field.

c. If customers should call a particular number for more information, then 
enter the phone number.
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d. If the sales organization should use a script when talking to customers who 
call in, from the Script field click Go and use the LOV to select the desired 
script.

8. In the Audience region, enter the lists of prospects or customers targeted by this 
activity:

a. Use the Name drop-down list to select the list. The list selected must have a 
status of Active.

b. To execute the campaign immediately, select the Execute checklist.

9. Click Update.

If this activity is an email blitz and the Execute check box is selected, your email is 
mailmerged and sent automatically.

References
Executing Marketing Activities Through Schedules

Creating an Email Blitz

Entering Information About Campaign Geography
Use this procedure to enter information in the Geography item on the side panel 
menu.

Prerequisites
Geographical regions must be set up by your application administration.

Steps
1. Navigate to the Campaign Details page.

2. Click on the Geography item on the side panel menu. The Campaign Details - 
Geography page appears.

3. Using the Level drop-down list, select the level of the geographical area to 
attach to the campaign.

Note: After a list has been used for a campaign schedule, the 
status of the list is updated from Available to Locked. You cannot 
reuse the same list again with that or any other campaign 
schedule. To use same list entries again, create the new list.
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4. In the Name field, click Go and use the list of values to enter a geographic 
location for the level selected in the previous step. 

5. Click Update.

6. Repeat this procedure for additional geographical locations.

Creating Offers
Use this procedure to create discounts and offers for campaigns and products using 
the Offer item on the side panel menu. 

Prerequisites
An existing campaign.

Steps
1. Navigate to the Campaign Details page.

2. Click the Offer item on the side panel menu. The Campaign Details - Offer page  
appears.

3. From the Type drop-down list select an offer type.

4. Enter an offer name.

5. Enter a unique offer code.

6. Enter the dates the offer will remain active. These dates must fall within the 
range of active dates of the campaign.

7. Click Update.

8. To add details about the offer, then click Setup and follow the procedure 
corresponding to the offer type selected:

■ Accrual

■ Lump sum

■ Off invoice

■ Order value

■ Promotional goods

Guidelines
See Offers for a definition of offer types.
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Entering the Details of an Accrual Offer
Use this procedure to enter the details about an accrual offer. 

Prerequisites
An existing offer.

Steps
1. Navigate to the Offer Details -- Accrual page. From the Offer page, click Setup 

next to the accrual type offer you.

2. Optionally, select a status.

3. Enter the dates customers can order under this offer. These dates must fall 
within the active dates of the campaign.

4. Enter the dates customers can receive shipments for goods ordered under this 
offer. These dates must fall within the dates of the campaign.

5. Do not make entries in Performance Dates Between fields. These are used for 
Trade Management. 

6. To restrict the offer to a product family:

a. In the Product region use the Level drop-down list to select a Product 
Family. 

b. The offer is valid for every product in the product family. To exclude certain 
products in the family from the offer, after completing this procedure,  use 
the Products item on the side panel menu to exclude them. 

7. If a customer is required to purchase a minimum number of products to qualify 
for the offer:

a. In the UOM field, click Go and use the list of values (LOV) to enter the 
units used to measure the products. 

b. In Quantity, enter the minimum quantity required to qualify for the offer.

8. To create tiered discounts, select the Tiered? check box and follow the 
instruction on setting up tiered discounts using the Advanced Options item on 
the side panel menu.

9. In Base Rate, enter the amount of your discount either as an amount or as 
percent. Select the amount type from the drop-down list.
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10. If there is a limit on the number of units or amount of product may purchase 
under the offer, enter that amount in the Maximum Cap field.

11. To limit the offer to those customers within one or more market segments, select 
the Market item on the side panel menu and enter the market segment(s). 
Limiting the offer to a market segment means that customers outside that 
market segment cannot take advantage of the offer. 

12. Click Update.

13. Fill in additional information in the other items on the side panel menus.

Guidelines
The list below includes all item on the side panel menus used by offers. 

Depending on the implementation, only a subset of these attributes may be listed 
on the sided panel menu for the offer. 

■ Advanced Options 

■ Attachments 

■ Budgets

■ Costs 

■ Metrics 

■ Notes

■ Products

■ Tasks 

Entering the Details of a Lump-Sum Offer
Use this procedure to enter the details for a lump-sum offer. This type of discount is 
used for Trade Management only. It provides the customer a lump sum amount as 
cash or accrual. The lump sum is usually a payment for the customer’s promotional 
activities on the organization’s behalf.

Prerequisites
An existing offer.
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Steps
1. Navigate to the Offer Details -- Lump Sum page. Click setup next to the Lump 

Sum offer.

2. In the Performance Date fields enter the period of the promotional activity.

3. In the Lumpsum field, enter the amount to be paid to the customer.

4. From the Payment Type drop-down list, select either:

■ Check: Select if the customer is paid by check.

■ Accrue: Select if the lump sum accrues for later payment or used for  
short-payment of invoices.

5. Click Update.

Entering the Details of an Off-Invoice Offer
Use this procedure to enter the details of an off-invoice offer. 

Prerequisites
An existing offer.

Steps
1. Navigate to the Offer Details -- Off Invoice page. From the Offer item on the 

side panel menu, select Details next to the off-invoice offer.

2. Optionally, select a status.

3. Enter the dates customers can order under this offer. These dates must fall 
within the date range of the campaign.

4. Enter the dates customers can receive shipments for goods ordered with this 
offer. These dates must fall within the date range of the campaign.

5. Do not make an entry in Performance Dates Between fields. These are used for 
Trade Management.

6. Specify the product or product family for this offer in the Product section:

a. From the Level drop-down list, select Product or Product Family. 

b. In the Product field, click Go and use the list of values to select the product 
or product family.
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c. If a product family is selected, the offer is valid for every product in the 
product family. To exclude certain products in the family from receiving 
this offer, after you complete this procedure, use the Products item on the 
side panel menu to exclude the individual products from the offer. 

7. In the UOM field, click Go. Select a unit of measure from the list of values. 

8. For a non-tiered offer:

a. In Quantity, enter the minimum quantity a customer has to purchase to 
qualify for the offer.

b. In Base Rate, enter the amount of the discount either as an amount or as 
percent. Select the amount type from the drop-down list.

9. For a tiered offer:

a. Leave the Quantity and Base Rate fields blank.

b. Select the Tiered? check box. 

c. After completing this procedure follow the instruction on setting up tiered 
discounts using the Advanced Options item on the side panel menu.

10. If there is a limit on the value of the product a customer can purchase under  
this offer, enter that amount in the Maximum Cap field. 

11. To limit the offer to those customers within one or more market segments,  
select the Market item on the side panel menu and enter the market segment(s). 
Limiting the offer to a market segment means that customers outside that 
market segment cannot take advantage of the offer.

12. Click Update.

13. Fill in additional information in the other items on the side panel menu.

Guidelines
The list below includes all items on the side panel menu used by offers. 

Depending on your implementation, only a subset of these attributes may be listed 
on the side panel menu for an offer. 

Note: Only one product or one product family may be selected for 
an offer. Use the Products item on the side panel menu to exclude 
individual products from a product family.
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■ Advanced Options 

■ Attachments 

■ Budgets

■ Costs 

■ Metrics 

■ Notes

■ Products

■ Tasks 

Entering the Details of an Order-Value Offer
Use this procedure to enter the details for an order-value offer. This type of offer 
depends on the total value of the customer’s order. 

Prerequisites
An existing offer.

Steps
1. Navigate to the Offer Details -- Order Value page. From the Offer item on the 

side panel menu, click Setup next to the off-invoice offer.

2. Optionally, select a status.

3. Enter the dates customers can order using this offer. These dates must fall 
within the date range of the campaign.

4. Enter the dates customers can receive shipments for goods ordered with this 
offer. These dates must fall within the date range of the campaign.

5. If there are tiered discounts for the offer, select the Tiered? check box. 

6. In the Discount Rules section, enter the discount level(s) for each product or 
product family:

a. In the From field, enter the minimum order amount that will trigger the 
discount.

b. In the To field, enter the order amount for the upper limit of the discount. 
Entry in this field is optional. 
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c. In the Product field, click Go and select a product or product family from 
the list of values. To exclude individual products in the family from the 
offer, after completing this procedure, use the Products item on the side 
panel menu to exclude them. 

d. In UOM, click Go and select a unit of measure for the offer.

e. Enter discount either as a percentage or a currency amount.

f. Repeat this procedure for each discount level and for each product or 
product family.

7. Click Update.

8. Fill in additional information in other items on the side panel menu.

Guidelines
The list below includes all items on the side panel menu used by offers. 

Depending on the implementation, only a subset of these attributes may be listed 
on the side panel menu for an offer. 

■ Advanced Options

■ Attachments 

■ Budget

■ Costs 

■ Metrics 

■ Notes

■ Products

■ Tasks 

Entering Details of a Promotional-Goods Offer
Use this procedure to set up a promotional-goods offer. This type of offer bundles 
promotional goods along with customer purchases.

Prerequisites
An existing offer.
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Steps
1. Navigate to the Offer Details --Promotional Goods page.  From the Offer item 

on the side panel menu, click Details next to the promotional goods offer.

2. Enter the dates customers can order under this offer. These dates must fall 
within the date range of the campaign.

3. Enter the dates customers can receive shipments for goods ordered under this 
offer. These dates must fall within the date range of the campaign.

4. Do not make an entry in the Performance Date fields. These fields are for trade 
management offers.

5. In the Buy section, select the products or product families the customer must 
purchase to qualify for the offer. Each product or product family must be listed 
in order to be included in the offer.

a. In the Product field, click Go and select a product or product family from 
the list of values (LOV). 

b. In the Name field, click Go and select a name of a product or product 
family from the LOV.

c. If a product family was selected, but individual products should be 
excluded qualifying under the offer, after completing this procedure, use 
the Products item on the side panel menu to exclude them. 

d. Enter the quantity of the product the customer must purchase to qualify for 
the offer.

e. In the Unit field, click Go and select the number of units for the quantity.

6. In the Get section, enter information about the product or products customers 
receive if they purchase products or product families specified in the Buy 
section:

a. In the Name field, click Go and select the product the customer will receive 
from the list of values.

b. Select the price list for the product.

c. Enter the number of units of the product the customer will receive.

d. In Discount, enter any discount either as an amount or percentage. 

7. Click Update.

8. Fill in additional information in the other items on the side panel menu.
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Guidelines
The list below includes all items on the side panel menu used by offers. 

Depending on the implementation, only a subset of these attributes may be listed 
on the side panel menu for your offer. 

■ Advanced Options 

■ Attachments 

■ Budgets

■ Costs 

■ Market

■ Metrics 

■ Notes

■ Products

■ Tasks 

Entering Advanced Details for Offers
Use this item on the side panel menu to:

■ Enter the discounts for tiered offers

■ Enter advanced pricing information. To set up advanced pricing using this side 
panel menu item, refer to the Oracle Pricing documentation.

Entering the Discounts for Tiered Offers
Use this procedure to enter the details of discounts available in tiered offers.

Prerequisites
An existing offer with the Tiered? check box selected.

Steps
1. Select to the Advanced Options item from the side panel menu.

2. Enter the discounts for the offer in the Discount rules section. For each level in 
the tier:
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a. In the From column, enter the quantity which qualifies for that level of 
discount. 

b. In the To column, enter the maximum quantity which qualifies for that level 
of discount.

c. To set up a tiered discount for a product or product family, use the Product 
list of values to specify the product or product family for this level of 
discount and the UOM list of values for the units of measure.

d. In the Discount field, enter the amount or percentage of the discount. 

e. Repeat this procedure for each discount level.

3. Click Update.

Associating Products with Campaigns, Offers, and Events
Use the Products item on the side panel menu to: 

■ Specify products and product families to either include or exclude from 
campaigns and events.

■ Specify which individual products to exclude from an offer that covers a 
product family

Prerequisites
An existing campaign, event or offer.

Steps
1. Navigate to the Products item on the side panel menu.

2. To exclude a product from an offer associated with a product family:

a. From the Level drop-down list, select Product.

b. In the Name column, click Go and select the product to exclude from the 
offer. The product must be from the same product family as selected for the 
offer.

c. Select the Exclude check box.

d. Click Update.

3. To include products or product families with campaigns or events:

a.  From the Level drop-down list, select Product or Product Family.
76 Oracle Marketing Online Concepts and Procedures



The Campaign Tab
b. In the Name column, click Go and select the product or product family to 
add to the offer from the list of values. 

c. Click Update.

4. To exclude a specific product from a product family associated with a campaign 
or event:

a. In the Level drop-down list, select Product.

b. In the Name column, click Go and select the product to exclude from the 
campaign or event. The product must be from the product family associated 
with the campaign or event.

c. Select the Exclude check box.

d. Click Update.

Triggering Campaign Actions Automatically
Use this procedure to automatically trigger a marketing action when a condition is 
met. For example, a secondary email blitz initiates automatically when the number 
of responses in a primary email blitz reaches a certain threshold.

Prerequisites
■ Schedules and Triggers must appear among the items on the side panel menu  

for your campaign. 

■ In Campaign Details, the currency for the budget must be selected.

Steps
1. Navigate to the Campaign Details page.

2. Select the Trigger item from the side panel menu.

3. The Campaign Details - Trigger page appears.

4. Using the Comparison Type drop-down list select a category for the trigger  (see 
the guidelines for an explanation).

5. Enter a name for the trigger.

6. Enter dates the trigger will be active. 

7. Click Setup.
Using Oracle Marketing Online 77



The Campaign Tab
The trigger details vary depending on the type of trigger. See the information 
for each specific trigger type below.

■ Date

■ Metric to Metric

■ Metric to Value

■ Metric to Workbook

Guidelines
There are four types of triggers:

References
Executing Marketing Activities Through Schedules

Entering Trigger Details
For more information on setting up a particular trigger type, see the sections noted 
below:

■ Entering Date Trigger Details

■ Entering Metric to Metric Trigger Details

■ Entering Metric to Value Trigger Details

■ Entering Metric to Workbook Trigger Details

Comparison Type Function

Date Executes the action on the date indicated.

Metric to Metric Executes the action based on a comparison of two metrics. For 
example, if the number of responses in one execution campaign 
is greater than the responses of another. 

Metric to Value Executes the action based on a comparison of a metric with a 
manually entered value. For example, when the number of 
responses of the campaign becomes greater than 5,000.

Metric to Workbook Executes the action when the comparison between the metric 
and a value generated by a Workbook query is true.
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Entering Date Trigger Details
Use this procedure to enter or edit information for a date type trigger.

Prerequisites
■ A date type trigger.

■ If the trigger initiates a schedule involving a list, the list must be created first.

Steps
1. Navigate to the Campaign Details - Trigger page:

■ If creating a new trigger, click Setup to display this page.

■ If editing a trigger, click the trigger name link to display this page.

2. Select a Time Zone from the drop-down list.

3. Enter the start date in the Start Date field.

4. Enter a time in the field to the right of the Start Date in the 12-hour format 
(HH:MI PM).

5. Leave all other fields in the Monitor Setup region blank.

6. In the Action region, select the Send Notification to Owner check box to send a 
reminder to the owner of the campaign on the Start Date. A notification is sent 
to the campaign owner on their Personal Home Page.

7. To trigger an email to a list:

a. Select the Generate List check box.

b. Select the list name from the drop-down list.

c. Select the appropriate radio button for immediate or delayed execution.

d. If an approval is required, select the Execute After Approval radio button.  
Click Go and select the name of the approver from the list of values.

8. Do not make entries in the Mail Preference region. Enter the required  
information in the schedule created automatically by the trigger. 

9. Click Update.

10. The Campaign Details page displays.

11. Select the Schedule item on the side panel menu.
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12. Click name link of the schedule just created. The schedule name is the same as 
the trigger name.

13. Follow the procedure for entering schedule details.

Entering Metric to Metric Trigger Details
Use this procedure to enter or edit information required to trigger a schedule when 
a metric meets a condition set by another metric.

Prerequisites
■ A metric to metric type trigger.

■ If the schedule initiated by the trigger requires a list, that list must be created 
first.

■ The metric setting the condition must be associated with the campaign.

Steps
1. Navigate to the Campaign Details - Trigger page:

■ If creating a new trigger, click Setup to display this page.

■ If editing a trigger, click the trigger name link to display this page.

2. Select a Time Zone from the drop-down list.

3. Enter the start date in the Start Date field.

4. Enter a time in the field to the right of the Start Date in the 12-hour format 
(HH:MI PM).

5. Enter an End Date and time to stop monitoring the condition for the trigger. The 
monitoring program checks the metric setting the condition as often as specified 
until the ending date and time.

6. Set up the frequency for checking the metric setting the condition.

a. Enter a number in the Frequency field.

b. From the drop-down list, select the time period.

c. In Daily Start Time and Daily End Time, enter the times for the program to 
run.

7. In the Condition region, use the Metric Name drop-down list to select the 
metric setting the condition. This metric must be associated with this campaign.
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8. Using the Metric Type drop-down list, select the value to be compared: actual, 
committed, or forecast.

9. From the drop-down list, select the mathematical operator for the comparison. 
For example, < for less than, or = for equal to.

10. Enter information on the comparison:

a. Use the Object Type drop-down list to select the type of object that contains 
the comparison metric. This can be any object on the Metric item on the side 
panel menu, including a campaign and event. Selecting an object type 
restricts the list of values available in the next step. 

b. In Object Name click Go and use the list of values (LOV) to select the object 
with the comparison metric.

c. Use the Metric drop-down list to select the comparison metric. Only the 
metrics associated with the object selected in the previous step appear in 
the list.

d. Using the Metric Type drop-down list, select whether to compare the actual, 
committed, or forecast value. The actual value is the value the metric has at 
the time the comparison is made.

11. In the Action section, select the Send Notification to Owner check box to send 
a reminder to the owner of the campaign.

12. To trigger an email to be sent to a list: 

a. Select the Generate List check box.

b. Select the list name using the drop-down list.

c. Check the appropriate radio button to schedule immediate or delayed 
execution.

d. If approvals are required, select the Execute After Approval radio button, 
click Go and use the list of values to select the person to approve the email 
blitz.

13. Do not make entries in the Mail Preference region. Enter all of the information 
in the schedule created automatically by this trigger. 

14. Click Update.

The trigger checks for the condition at the times specified in Monitor Setup. If the 
condition is met, the trigger creates a schedule and executes the blitz or waits for 
approval, if that condition was selected.
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Entering Metric to Value Trigger Details
Use this procedure to enter the details for a metric to value trigger.

Prerequisites
■ A metric to value type trigger.

■ If the schedule initiated by the trigger requires a list, that list must be created 
first.

Steps
1. Navigate to the Campaign Details - Trigger page:

■ If creating a new trigger, click Setup to display this page.

■ If editing a trigger, click the trigger name link to display this page.

2. Select a Time Zone from the drop-down list.

3. Enter the start date in the Start Date field.

4. Enter a time in the field to the right of the Start Date in the 12-hour format 
(HH:MI PM).

5. Enter an End Date and time to stop monitoring the condition for the trigger. The 
monitoring program value of the metric against the specified value as often as 
specified until the ending date and time.

6. Set up the frequency for checking the metric against the value.

a. Enter a number in the Frequency field.

b. From the drop-down list, select the time period.

c. In Daily Start Time and Daily End Time, enter the times for the program to 
run.

7. From the drop-down list, select the operator for the comparison. For example, < 
for less than, or = for equal to.

8. In the text box to the right of the operator, enter the value.

9. In the Action section, select the Send Notification to Owner check box to send 
a reminder to the owner of the campaign.

10. To trigger an email to be sent to a list: 

a. Select the Generate List check box.
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b. Select the list name using the drop-down list.

c. Check the appropriate radio button to schedule immediate or delayed 
execution.

d. If approvals are required, select the Execute After Approval radio button, 
click Go and use the list of values to select the person to approve the email 
blitz.

11. Do not make entries in the Mail Preference region. Enter all of the information 
in the schedule created automatically by this trigger. 

12. Click Update.

The trigger checks for the condition at the times specified in Monitor Setup. If the 
condition is met, the trigger creates a schedule and executes the blitz or waits for 
approval, if specified.

Entering Metric to Workbook Trigger Details
Use this procedure to enter the details for a metric to workbook trigger.

Prerequisites
■ A metric-to-workbook-type trigger.

■ If the schedule initiated by the trigger requires a list, that list must be created 
first.

Steps
1. Navigate to the Campaign Details - Trigger page:

■ If creating a new trigger, click Setup to display this page.

■ If editing a trigger, click the trigger name link to display this page.

2. Select a Time Zone from the drop-down list.

3. Enter the start date in the Start Date field.

4. Enter a time in the field to the right of the Start Date in the 12-hour format 
(HH:MI PM).

5. Enter an End Date and time to stop monitoring the condition for the trigger. The 
monitoring program value of the metric against the specified value as often as 
specified until the ending date and time.

6. Set up the frequency for checking the metric against the value.
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a. Enter a number in the Frequency field.

b. From the drop-down list, select the time period.

c. In Daily Start Time and Daily End Time, enter the times for the program to 
run.

7. In the Condition region, use the Metric Name drop-down list to select the 
metric you wish to use for comparison. The metric must be associated with 
your campaign.

8. From the drop-down list, select the operator for the comparison. For example, < 
for less than, or = for equal to.

9. Using the Workbook field to the right of the operator, select the workbook you 
are comparing the metric to.

10. In the Action section, select the Send Notification to Owner check box to send 
a reminder to the owner of the campaign.

11. To trigger an email to be sent to a list: 

a. Select the Generate List check box.

b. Select the list name using the drop-down list.

c. Check the appropriate radio button to schedule immediate or delayed 
execution.

d. If approvals are required, select the Execute After Approval radio button, 
click Go and use the list of values to select the person to approve the email 
blitz.

12. Do not make entries in the Mail Preference region. Enter all of the information 
in the schedule created automatically by this trigger. 

13. Click Update.

The trigger checks for the condition at the times you specified in Monitor Setup. If 
the condition is met, the trigger creates a schedule and executes the blitz or waits for 
approval, if selected.

Handling Responses to a Campaign or Event
Use this procedure to set up response handling for an execution campaign or an 
execution event using the Response item on the side panel menu.
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Prerequisites
None

Steps
1. Navigate to the Response item on the side panel menu.

2. If prospects will respond to the campaign or event by telephone, then: 

a. Use the Script list of values (LOV) to select an appropriate script. Scripts are 
created in Oracle Scripting, not in Oracle Marketing Online.

b. Enter the phone number prospects use in the Phone field.

3. If prospects are responding by email, enter the email address.

4. If prospects are responding on a web site, then enter the URL.

5. Click Update.

Entering Information About Partners
Use this procedure to enter a list of partners using the Partner item on the side 
panel menu.

Prerequisites
None

Steps
1. Navigate to the Campaign Details page.

2. Click on the Partner item on the side panel menu.

The Campaign Details - Partner page appears.

3. In Name, click GO and use the list of values to select a partner name.

4. Click Update.

5. Repeat this procedure to add additional partners.

Getting Approval for Your Campaign Theme
Use this procedure to obtain approval for a new campaign.
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Prerequisites
■ A new campaign.

■ The application administrators must enable the approval work flows for 
campaigns.

Steps
1. Navigate to the Campaign Details page of the campaign needing approval.

2. From the Status drop-down list, select Planned.

3. Click Update.

The status becomes "Pending Theme Approval" and the application sends a 
notification with the request for approval, along with basic campaign information, 
to approver specified by the application administrators.

A notification appears on the Personal Home Page after the approver approves or 
rejects your campaign theme. If the campaign theme is rejected, the status becomes 
"Denied Theme Approval". If the campaign theme is approved, the status becomes 
"Planned."

See Also
How campaigns are approved

Getting Approval for a Campaign Budget
Use this procedure to obtain approval for a campaign budget. 

Prerequisites
■ A new campaign.

■ The application administrators must enable the approval work flows for 
campaigns.

Steps
1. Navigate to the Campaign Details page for the campaign.

2. Enter the budget currency and budget amount for the campaign.

3. From the Status drop-down list, select Active.

4. Click Update.
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The status becomes "Pending Budget Approval" and the application sends a 
notification with the request for approval, along with basic campaign information, 
to approver specified by the application administrators.

A notification appears on the Personal Home Page after the approver approves or 
rejects your campaign budget. If the campaign budget is rejected, the status 
becomes "Denied Budget Approval". If the campaign theme is approved, the status 
becomes "Active."

See Also
How campaigns are approved

Copying a Campaign
Use this procedure to copy an existing rollup or execution campaign.

Prerequisites
The campaign must be listed under My Campaigns indicating permission to copy it.

Steps
1. Navigate to the Campaign tab.

2. Select the link for the campaign to be copied. 

The Campaign Details page appears.

3. Click Copy. 

The Copy Campaign page appears.

4. Make sure that the campaign to be copied appears in the Source Campaign 
field. If it does not, select it using the list of values (LOV).

5. Enter a name for the new campaign. 

6. Do not enter a Source Code. This field will be populated by the application 
automatically. 

7. Enter the dates the new campaign is effective.

8. In the Select Attributes for Copying region, select the check boxes of the items  
to copy to the new campaign. Only the attributes populated with data appear 
on the list.

9. Click Copy Now. 
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The new campaign is created.

10. Click the Campaign subtab.

11. Click the link of the new campaign

12. If required, place the campaign into the campaign hierarchy by entering a 
parent campaign in the Parent field. 

13. Edit the details or add additional information for the new campaign.

Setting Up Approval Rules
Use this procedure to create approval rules for:

■ Budgets

■ Campaigns

■ Deliverables

■ Execution Events

■ Rollup Events

Prerequisites

A default approval role must be established by the organization’s application 
administrators. Appropriate privileges to create an approval rule are required. 

Steps
1. Navigate to Administration > Setup > Approval Rule > Create.

2. Use the Approval Rule For drop-down list to select a the type of approval rule 
you want to create.

3. Enter a name for the approval rule you are creating.

4. Click the calendar button and select a date for the approval rule to become 
active.

5. In the next field, click the calendar button and select an end date for the 
approval rule.

6. Click Go to display a list of available organizations and select one.
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7. From the appropriate drop-down menus, choose a business unit, an approval 
type, a priority, a set-up type, a budget category, a minimum and maximum 
amount and a description. (Each of these eight fields are optional entries.)

8. Click Create.

The Deliverables Tab
Use the Deliverable tab to store and track the electronic files for your creative 
projects and campaigns. Physical deliverables may also be tracked using the 
Deliverables tab.

Help is available on:

■ Viewing and editing a deliverable

■ Creating a deliverable

■ Creating a kit of deliverables

 Viewing and Editing a Deliverable
Use this procedure to view and edit an existing deliverable.

Prerequisites
None

Steps
1. Navigate to the Deliverable tab.

2. If the desired deliverable is not displayed in the list, search for it by changing 
the View, or using QuickFind and Advanced Search.

3. Click on the link of the deliverable to view or edit it. The Deliverable Details 
page displays. 

4. Edit the information on the details page.

5. Click Update.

Creating Deliverables
Use this procedure to create deliverables.
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Prerequisites
None

Steps
1. Navigate to the Deliverable tab.

2. Click Create.

The Create Deliverable subtab appears.

3. Enter a unique name.

4. Enter a version for the deliverable. Usually this number will be 1 because you 
are creating a new deliverable.

5. Select a status.

6. In Available From and Available To fields, enter the dates this deliverable will 
be available for use.

7. In Due Date, enter the deadline for this deliverable. The deadline must fall on or 
before the Available From date.

8. To disallow viewing or editing of the deliverable, select the Private check box.

9. Select a language if other than the default.

10. Classify the deliverable by selecting a Type and a Subtype from the drop-down 
lists.

11. To change the deliverable owner, use the Owner list of values (LOV) to select a 
different person.

12. In Budget Amount, enter the currency and the budget for this deliverable.

13. Enter a description.

14. Click Create.

More information may be entered for the deliverable, including adding associated 
electronic files as attachments.

Note: Oracle Marketing Online does not maintain versions. A new 
version will overwrite the previous version.
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Entering or Editing Detailed Deliverable Information
Use this procedure to enter or edit information about a deliverable.

Prerequisites
An existing deliverable.

Steps
1. Navigate to the Deliverable tab.

2. If the deliverable is not displayed in the list, search for it by changing the View, 
or using QuickFind and Advanced Search.

3. Click the deliverable hyperlink.

The Deliverable Details page appears.

4. To create a new version of a deliverable, enter a new version number. 

5. Edit fields as desired. 
 

6. If the deliverable includes electronic files, attach those files by selecting the 
Attachment item on the side panel menu and following the instructions for 
creating an attachment.

7. Fill in information in the other items on the side panel menus.

Guidelines
The list below includes all item on the side panel menus used for deliverables. 

■ Budgets: Used to request funds for the deliverable.

■ Inventory and Kit: Used to create a kit and enter it into inventory.

■ Attachments 

■ Costs

Note: You can edit all fields of deliverables except for the Due 
Date. This can only be changed by an administrator.

Note: Oracle Marketing Online does not maintain versions. A new 
version will overwrite the previous version.
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■ Metrics 

■ Notes 

■ Tasks 

Creating a Kit of Deliverables
Use this procedure to add existing deliverables to a kit deliverable. Create a kit type 
deliverable first and then use this procedure to add the deliverables that comprise 
the kit.

Prerequisites
A kit type deliverable.

Steps
1. Navigate to the Inventory and Kit item on the side panel menu for a kit 

deliverable.

2. If the kit is made up of electronic files, select the Managed Electronically radio 
button.

3. If the kit is made up of physical collateral, then:

a. Select the Managed Physically radio button.

b. If you are keeping the kits as part of inventory, then select the Stock 
Manually radio button and enter the quantity you have in the Quantity 
field.

c. If the kit is to become an inventory item, then enter an inventory part 
number in the Part Number field.

4. In the Kit section, select the deliverables that are a part of this kit:

a. Select the name of a deliverable from the Name list of values.

b. Click Update.

c. Repeat this procedure for each deliverable in the kit.

5. Click Update.
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The Event Tab
Use the Event tab to manage marketing events.

Help is available on:

■ Viewing and editing a rollup event

■ Viewing and editing an execution event

■ Creating a rollup event

■ Creating an execution event

You can obtain more information about events in:

■ Understanding events

Viewing and Editing a Rollup Event
Use this procedure to view and edit an existing rollup event.

Prerequisites
None

Steps
1. Navigate to Event > Event subtab.

2. If the desired event is not displayed in the list, search for it by changing the 
View, or using QuickFind and Advanced Search.

3. Click on the event name link to view or edit.

The Event Details page displays.

Viewing and Editing an Execution Event
Use this procedure to view and edit an existing execution event.

Prerequisites
None

Steps
1. Navigate to the Event > Event subtab.
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2. If the desired event is not displayed in the list, search for it by changing the 
View, or using QuickFind and Advanced Search.

3. Click on the event name link to view or edit.

The Event Details page displays.

Creating a Rollup Event
Use this procedure to create a rollup event. A rollup event holds the general 
description of an event and provides the structure for reporting costs and 
dispersing budgets to individual sessions of the event. If your company is planning 
to train the sales force in different cities on your new product line, for example, then 
the rollup event holds information about the course content and the budgets for the 
individual sessions to be held in the different cities.

Prerequisites
None.

Steps
1. Navigate to the Events > Events.

2. Click Create. 

The Create Event Page appears.

3. Use the Setup Type drop-down list to select the type of event to create. Selecting 
a type determines which fields are presented. These types are set up by your 
administrator. 

4. Leave the Source Code field blank. It gets filled automatically with a unique 
code after the event gets created.

5. Enter a name for the event according to naming conventions for your 
organization, if any.

6. Enter the start date and end date for the event.

7. Optionally, enter the duration of the event. 

8. Enter the person who is approving budgets or other activities for this event in 
the Owner field.

9. Enter a description of the event.

10. Click Create.
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The Rollup Event Details page appears.

Entering or Editing Information for a Rollup Event
Use this procedure to add or to edit details for a rollup event. 

Prerequisites
An existing rollup event.

Steps
1. Navigate to the Rollup Event Details page.

2. Enter the budget currency and budget amount.

3. Select applicable check boxes:

■ Confidential: The information is not released on any web site or 
telemarketing application.

■ Invite Only

■ Registration Required 

■ Payment Required

4. Complete information for the items on the side panel menu. More information 
on each item is found in the Guidelines section.

Guidelines
If you have budget approvals activated for this setup type, then the budget amount 
you entered here is automatically passed on your manager for approval.

The list below includes all available items on the side panel menu used for rollup 
events. 

Only a subset of these attributes may appear on the side panel menu for a given 
rollup event. This is because different types of events require different types of 
information. 

■ Attachments 

■ Budget

■ Campaign

■ Costs
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■ Deliverable

■ Event Agenda

■ Execution Event

■ Market

■ Message 

■ Metrics 

■ Notes 

■ Partner

■ Products

■ Resource

■ Response

■ Tasks 

■ Team 

Promoting an Event by Associating It with a Campaign
Events may be promoted by associating the event with a campaign. Use this 
procedure to associate the event with a campaign.

Prerequisites
An existing campaign and an existing event.

Steps
1. On the Rollup Event Details page, click the Campaign attribute.

The Rollup Event Details - Campaigns page displays.

2. Use the Campaign Name list of values (LOV) to select the campaign to associate 
with the event. 

3. Click Update to save.
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Entering an Event Agenda
Use this procedure to enter the agenda for a rollup or execution event. If the event 
has multiple activities happening at the same time, split up the event agenda into 
separate tracks.

The agenda for a rollup event will be automatically copied to the execution events  
linked to that rollup event. Each execution event agenda may be modified to add 
details pertinent to the specific execution event. The agenda for an execution event 
is valid only for that execution event.

Prerequisites
An existing rollup or execution event.

Steps
1. For each item on the agenda:

a. If the event takes place over a number of days, then select the day of the 
event.

b. In the Name field, enter the name of the activity.

c. If multiple activities are taking place at the same time, create tracks for 
related activities, so they may be scheduled without overlap.

d. Enter a start time and end time for the activity. Times must be in the 
12-hour format (HH:MI PM).

2. Click Update.

3. In the Details column, click the Setup link to the right of each agenda item 
created and enter any speaker information or notes for the item.

Entering Speakers and Other Details for an Event
Use this procedure to enter the speaker and other details for an agenda item.

Prerequisites
An existing event with an agenda.

Steps
1. Navigate to the Rollup Event Details - Agenda Details page.

2. If the agenda has a coordinator, then enter it in the Coordinator field.
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3. If there is a speaker for this agenda item, then click Go next to the Name field 
and use the list of values (LOV) to select the speaker’s name.

4. From the Status drop-down list, select the confirmation status for the speaker.

5. Enter any optional comment in the comment field. 

6. To enter a note:

a. Using the drop-down list, select the note type.

b. Enter the note.

c. Click Update.

Entering Event Venues, Coordinators, and Other Resources
Use this procedure to enter venues, coordinators and other resources for the event. 

Prerequisites
An existing event. 

Venues must be established in administrative setup.

Steps
1. Navigate to the Rollup Event Details - Agenda Details page.

2. Using the Type drop-down list, select the type of resource to associate with the 
event.

3. If the resource is a person, then enter the person’s name and role.

4. Select a status from the Status drop-down list.

5. Click Update.

Creating an Execution Event
Use this procedure to create an execution event. An execution event tracks 
individually occurring events. An execution event records participation and 
enrollment.

Prerequisites
An existing rollup event.
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Steps
1. Navigate to Event > Event. Click Create.

2. In Event Name, enter the name of the rollup event to associated this event with.

3. In the Execution Event Name field, enter the name of the event.

4. Select the type of event.

5. If the person responsible for this event is other than yourself, enter that person’s 
name in the Owner field.

6. From the Setup Type drop-down list, select the custom setup for the event. The 
custom setup is created by the application administrator and determines the 
type of information to track with an execution event.

7. Make entries in other optional fields.

8. Click Create.

The Execution Event Details page appears. 

Entering or Modifying Details for an Execution Event
Use this procedure to enter or modify details about an execution event.

Prerequisites
An existing execution event.

Steps
1. Navigate to the Event Details page. This page appears automatically when you 

create a new execution event. You can also reach it by the following method:

a. Navigate to Event > Execution Event

b. Select the hyperlink for the execution event you wish to modify.

c. Select the General item on the side panel menu.

2. The Source Code field is automatically populated with the unique identifying 
code generated by the application for this execution event.

3. Enter the budget currency and budget amount.

4. To assign ownership of this event to someone else, use the Owner List of Values 
to select a different individual.
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5. Enter the start and end dates when this event will be available for use.

6. Enter the duration of the event.

7. In Venue, use the LOV to select the venue where the event is to be held.

8. Make entries in other optional fields, as desired.

9. Select applicable check boxes:

■ Confidential: the information is not released on any web site or 
telemarketing application.

■ Invite Only:

■ Registration Required: 

■ Payment Required:

10. Click Update.

11. Complete information in the various items on the side panel menu. In the list 
below, click the link corresponding the desired attribute.

Guidelines:
The list below includes all item on the side panel menus used for rollup events. 

Only a subset of these attributes may be listed on the side panel menu.

■ Attachments 

■ Budget

■ Campaign

■ Costs 

■ Deliverable

■ Event Agenda

■ Invite List

■ Market

■ Message 

■ Metrics 

■ Notes 

■ Partner
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■ Products

■ Publishable Notes

■ Registration

■ Resource

■ Response

■ Tasks 

■ Team 

Setting Up Event Registration
Use this procedure to specify registration details for an execution event. This 
includes determining enrollment numbers and pricing. 

Prerequisites
An existing execution event.

Steps
1. Navigate to the Execution Event Details page and select the Registration item 

from the side panel menu.

The Execution Event Registration Setup page appears.

2. In the Maximum Size field, enter the maximum number of registrants.

3. To limit registration to the number of registrants you entered in the Maximum 
Size field, select the No Overbooking radio button.

4. To allow people to continue to register for the event regardless of the number 
entered in the Maximum Size field, select the Allow Overflow radio button. 

5. To allow overbooking in anticipation of cancellations, select the Overbook by 
radio button.

6. Enter the allowed percentage of overbooking. For example, if the maximum 
number of registrants is 100 and you enter 10% then the application will allow 
up to 110 people to attend your original event. To continue to allow registrant 
application even when registration is full, then:

a. Select the Waitlist Enabled check box.
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b. Specify the allowed size of the waitlist by entering a percentage value in the 
Waitlist field. 

c. Select a waitlist rule. The default is First Come First Serve: the first person 
on the waiting list gets the first available place. 

7. Enter the minimum size for this event. This number can be used to trigger a 
cancellation of the event or further campaign activity if the minimum 
enrollment is not met by the date entered in the Attain Minimum By field. 

8. In Attain Minimum By field, enter a date by which the event must reach a 
minimum enrollment. 

9. Select the enrollment start day and time.

10. Enter the enrollment end day and time.

11. Specify the time zone to further clarify the dates and times.

12. If there is a charge for the event, enter the cost and payment details. This 
information will be added to inventory:

a. If the attendee cost is based on a price list, select the applicable price list.

b. To enter an event price, then enter an amount and the applicable currency.

c. For a non-cash payment, select the credit type that is accepted for payment.

d. Enter the number that will become the inventory number for this event. 

13. If the organization awards credits for attendance: 

a. From the Credit Type drop-down list, select the type of credits awarded.

b. Enter the number of credits awarded for attendance at this event.

14. To view the status of registration, then click the View List hyperlink.

15. Click Update to save.

Viewing the Status of Registration for an Event
Use this procedure to view the status of a registration for an event.

Prerequisites
Registration for an event must be handled by a related application such as Oracle 
TeleSales or Oracle Marketing Online.
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Steps
1. Navigate to the Execution Event Details subtab and select the Registration 

hyperlink.

The Execution Event Registration Setup page appears.

2. Click the View List link at the bottom of the page.

Execution Event Details - Registration List subtab appears displaying the 
registrants for the event and their status.

Publishing Event Notes on Your Web Site
Use this procedure to publish notes about an execution event on a company’s web 
site. Oracle Marketing Online cannot specify the presentation of the information, it 
may be used to enter the text to be published.

Prerequisites
Oracle Marketing Online must be configured to work with an organization’s web 
site via a product such as Oracle iStore.

Steps
1. Navigate to the Execution Event Details page and select the Publishable Notes 

item on the side panel menu.

The Execution Event Details - Notes subtab appears.

2. To view an existing note, then click on the note link at the bottom of the page 
under the Note History heading.

3. To enter a note to be published:

a. Select an optional Note Type.

b. Enter the note.

c. Click Update.

Specifying the Invitation List for an Execution Event
Use this procedure to specify the list of people to invite to an execution event.

Prerequisites
A list of invitees.
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Steps
1. Navigate to the Execution Event Details page and select the Invite List item 

from the side panel menu.

The Execution Event Details - Invitation List page appears.

2. Use the List Name list of values (LOV) to select the list name.

3. Click Update.

Using the Budget Tab
Use the budget tab to set up budgets that are used to pay for campaigns, offers, 
events, and deliverables. To draw funds from an existing budget, use the Budget 
item on the side panel menu in the individual campaign, event, or deliverable 
instead. 

Help is available on:

■ Viewing budgets

■ Creating a budget

■ Editing budget information

■ Allocating budgets

■ Check how budgets are spent

■ Request the transfer of funds from one budget to another

For more information on budgets see:

■ Understanding Budgets

Viewing Budgets
Use this procedure to view budgets.

Prerequisites
None

Steps
1. Navigate to the Budget tab.
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The budget tab displays a list of budgets for the view displayed in the View 
drop-down list.

The list displays budgets in a hierarchy. Any budget marked with an icon 
depicting a folder and a plus sign contains other budgets that are dependent on 
it. Click the icon to view the budget hierarchy.

2. If the desired budget is not among those displayed in the list, then select an 
alternate View, or search for it using QuickFind and Advanced Search.

3. Click on the hyperlink of the Budget to view or edit it.

The Budget Details page displays.

Creating a Budget
Use this procedure to create a budget.

Prerequisites
None

Steps
1. Navigate to the Budget tab.

2. Click Create. 

The Create Budget subtab appears.

3. Enter the budget name.

4. In Number, enter a unique identification number.

5. If this budget is subordinate to another budget, then click Go in the Parent field 
and use the list of values to select the parent budget.

6. In Budget Amount, enter an amount as a whole number. No spaces, commas or 
decimal points are allowed.

7. If the budget is in a currency other than the default currency shown in the 
Currency field, select the appropriate currency from the drop-down list.

8. In Holdback Amount, enter the amount to be held as a reserve.

9. From the Category drop-down list, select a budget category.

10. Use the Department drop-down list to select a department.
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11. If you are not the owner of this budget, then, in Owner, click Go and use the list 
of values to select a different owner.

12. Leave Status as Draft. The status will be updated automatically when the 
budget is created.

13. Enter the dates the budget is to remain active.

14. Do not make entries in the General Ledger and Accrual Parameters unless the 
organization is utilizing Trade Management.

15. Click Create to create the budget.

16. The Budget Details page appears.

Entering or Editing Budget Information
Use this procedure to edit or enter budget details.

Prerequisites
None

Steps
1. Navigate to the budget tab and click the link of the desired budget to display 

the budget details page.

2. Fill in information in the various items on the side panel menu.

3. You may edit information in all the fields in this page.  These are the same fields 
filled out during budget creation. The guidelines section describes the fields.

4. Click Update.

Guidelines:
The list below includes all items on the side panel menu used for budgets. 

■ Allocation 

■ Checkbook 

■ Market

■ Notes 

■ Products

■ Team 
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Here are the fields you may edit:

Allocating Budgets
This item on the side panel menu is for use by Trade Management users to allocate 
budgets.

No help is available for this feature at this time.

Checking How A Budget is Spent 
Use this procedure to see how much money is left in a budget and how the money 
has been spent.

Field Description

Name Unique budget name.

Parent Name Name of a budget this budget is derived from. Make an entry 
here if you are creating a child budget.

Budget Amount The currency amount of your budget as a whole number. No 
spaces, commas or decimal points are allowed.

Holdback Amount  The amount to hold in reserve.

Category Budget category. Categories are determined by the 
implementation team.

Department The department.

Owner The person who owns the budget approves any charges against 
that budget.

Active From /Active To Budget effective dates.

Status Triggers Workflow approval. Changing the status to Active 
requests approval from your manager.

Expense Account Reserved for Trade Management.

Accrual Account Reserved for Trade Management.

Basis Reserved for Trade Management.

Accrual Cap Reserved for Trade Management.

Rate Reserved for Trade Management.
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Prerequisites
None

Steps
1. Navigate to the Checkbook item on the side panel menu:

a. Navigate to the Budget Tab. Click on the desired budget to display the 
budget details page for that budget.

b. Click the Checkbook item on the side panel menu.

2. To view further details on the total, planned, committed, earned, or paid 
amounts, click the currency amounts in those lines. Each of these currency 
amounts is linked to a report which appears in a separate page.

Requesting Transfer of Funds from One Budget to Another
Budget creators can use this procedure to request the transfer funds from one 
budget to another.

Prerequisites
Permission to create budgets. Both the granting budget and the receiving budget 
must have the status of active for the transfer to take place.

Steps
1. Navigate to the Budget > Budget Transfer.

2. The Budget Transfer page appears.

3. Click Go in the Name field and use the list of values (LOV) to select the budget 
to transfer funds from.

The owner and remaining funds appear for the budget you selected.

4. In Requested Amount, enter the amount of the budget to transfer.

5. In Transfer To, click Go and use the LOV to select the budget the funds are 
going to.

6. Click Transfer.

7. If you are the owner of both budgets, then the budget amount is transferred 
automatically:

a. The Budget Transfer confirmation page appears.
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b. Click OK.

8. If you are not the owner of the budget, your request is submitted to the budget 
owner and your supervisor for approval. The amount if transferred on their 
approval.

Guidelines
Understanding Budgets

Using the Administration Tab
The Administration tab is where features that include marketing activities, 
marketing mediums, and the custom setups which determine the item on the side 
panel menus that appear in campaigns and events are set up. 

Some of the features of the Administration tab are available for marketing super 
users. Use this tab for: 

■ Setting up marketing mediums for campaigns

■ Setting up activity classifications

■ Creating custom setups for campaigns and events 

■ Enable campaign and event approval workflow

■ Creating venues for events

■ Creating an email blitz

In addition, application implementers and administrators can use features of this 
tab to:

■ Set up the data fields to restrict the number of columns available for list 
generation

■ Set up deduplication rules

■ Create categories and subcategories

■ Create a list of similar words used to identify duplicate records

■ Mapping your customer model to Oracle Marketing Online

■ Create metrics
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Creating an EMail Blitz
Use this procedure to create an email blitz.

Prerequisites
Use the seeded campaign custom setup of a Direct Marketing - Email. 

Steps
1. Create the email cover letter for mailmerge.

1. Create and execute a list of email recipients as described in Creating a List.

1. Create an execution campaign of campaign type Direct Marketing - Email 
according to the procedure found in Creating an Execution Campaign.

2.  Create a schedule.

3. In the Schedule details, enter the cover letter, the list you have created, and 
other details according to the procedure outlined in Entering Details for the 
Activity You Wish to Schedule. Select the Execute check box. Click on Schedule. 
The email blitz is executed when you click Update in the Schedule Details 
subtab.

Creating an Email Cover Letter for Mail Merge 
Use this general procedure to create an email cover letter that will be mail-merged 
and sent to customers. 

Prerequisites
None

Steps
1. Create an HTML email cover letter using any HTML editor.

2. In the cover letter, insert the fields to be mail merged where you want the 
mailmerge text to appear. 

Note: When a list is selected for a campaign schedule, the status 
of the list is updated from Available to Locked. The list cannot be 
reused with that or any other campaign schedule. To use same list 
entries again,  recreate the new list.
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The fields must be surrounded by special double arrow bracket characters. For 
example: <<title>> <<first_name>> <<last_name>>. You can add 
these double brackets into the HTML source by adding &laquo; for the left 
bracket and &raquo; for the right bracket. For a list of available merge fields 
see Available Mailmerge Fields.

Here is what the HTML looks like for the salutation for the email:

Dear&laquo;title&raquo; &laquo;first_name&raquo; 
&laquo;last_name&raquo;

3. If the HTML cover letter you created contains images, then:

a. Create folder named Images and place the images in it.

b. Use the WinZip utility to zip up the HTML file and the Images folder with 
the images. You can ensure that the Image folder is preserved adding files 
using the Add Files with Wildcards Button.

c. Name the Zip file in a way that will enable users to recognize the cover 
letter contents.

4. Navigate to Administration > Fulfillment > Master Document

5. Click Upload. 

The Master Document subtab appears.

6. Click Upload. 

The Upload Master Document subtab appears.

7. Click Browse.

8. Select the zip file prepared with the email cover letter contents.

9. Click Upload.

10. The Master Document subtab appears with the uploaded zip file listed in the 
Master Document Name column.

11. Using the Query drop-down list select source of the mail merge fields you are 
using. This can be one of the two seeded queries, the Marketing Simple Query 
or the Marketing Detailed Query, or a query developed by your implementation 
team.

12.  Click Update. 

The cover letter is now ready for use in a marketing campaign.
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Searching 
Use this procedure to search the Oracle Marketing Online database for messages, 
campaigns, deliverables, events, and lists. Search will not locate notes, attachments 
and tasks associated with marketing objects. Locate the appropriate message, 
campaign, event, or other object to view notes, attachments and tasks associated 
with that object.

Prerequisites
None

Steps
1. Enter at least a part of the name of the object in the search field and click Quick 

Find to locate the object.

2. If the object name is unknown:

a. Use Advanced Search to find the object and note its name.

b. Use Quick Find to locate the desired object.

Searching Using Quick Find
Use this procedure to search for campaigns, events, and other objects in Oracle 
Marketing Online.

Prerequisites
None

Steps
1. Enter at least a part of the name of the object in the search field and click Quick 

Find to search for it in the database:

a. Select the type of object from the Quick Find drop-down menu.

b. Enter a partial or full name. You can use % to indicate omitted words or 
letters.
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c. Click Go.

The Search Results page displays the names of all of the found objects as 
links. 

d. Click the object name to display it.

Guidelines
For more information see Different Ways of Finding Information.

Advanced Search
Use this procedure to search for campaigns, events, deliverables or lists in Oracle 
Marketing Online using a number of search criteria. 

Prerequisites
None

Steps
1. Click Advanced Search.

2. In the Object Types region, indicate what type of object you wish to search for 
by selecting the appropriate check box(es). You may make multiple selections. 
Notes, messages, tasks and attachments are not searchable.

3. To search by a partial object name, its status, source code, or owner make 
entries in the Simple Query Criteria region fields. 

4. To search by the date an object is effective:

a. Estimate the dates by entering the general ledger periods in the Start Period 
and End Period fields. To enter the dates, click Go and select from the list of 
values.

b. Enter more precise dates in the Dates From and Dates To fields.

5. To search by purpose, select the appropriate check boxes in the Purpose region.

Note: To speed up searches, use the % wild card at the beginning 
or the end of a word or the sequence of words. For example, 
entering a search as %results is faster than a search for 
%results%. A search for Q1% is faster than a search for %Q1%.
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6. To search by activity type and activity, then:

a. Select the appropriate activity type check box(es).

b. Select the desired activities in the Activity list box. Select multiple activities 
by holding down the CTRL key on the keyboard.

7. To search by offer type, select the appropriate check box(es) in the Offer Type 
section.

8. To search by audience segment, select the segment(s) in the Segment list box. 
Select multiple activities by holding down the CTRL key on the keyboard.

9. To search by geographical location, click Add in the Geography region and 
select from the list of values to add the location(s). 

10. To search by product or by product categories, then click Add in the Product 
section and select the product(s) or product categories from the list of values.

11. To search by deliverable, click Add in the Deliverable section and select the 
deliverable(s) from the list of values.

12. To search by partner, then click Add in the Partner section and select the 
partner(s) from the list of values.

13. To search by message, then click Add in the Message section and select the 
message(s) from the list of values.

14. To search by workbook, then click Add in the Workbook section and select the 
workbook(s) from the list of values.

15. To search by list, then click Add in the Existing List section and select the list(s) 
from the list of values.

16. Click Search.

The Advanced Search Results page displays the results of the search. This list 
does not link to the objects themselves.

17. To view an object, then use Quick Find to search for and display the object.

18. To view more details about an object, follow the procedure outlined in Viewing 
Details About Advanced Search Results.

19. If the search results display too few or too many items, refine your search by 
reducing or increasing, respectively, the criteria used and repeat the search
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Viewing Details About Advanced Search Results
Use this procedure to view the results of your Advanced Search in more detail.

 Prerequisites
 Perform an Advanced Search first.

Steps
1. If the search results list the desired object(s):

a. Select the Select check box for each object to view it.

b. Click View Details.

A separate browser window lists information about the found items. 

2. If the search results display too few or too many items, refine your search by 
reducing or increasing, respectively, the criteria used and repeat the search

Entering Geography Search Criteria
Use this procedure to enter one or more geography regions as search criteria in the 
Advanced Search.

Prerequisites
None

Steps
1. Navigate to the Geography Locator window. Open it from the Geography 

region of Advanced Search by clicking Add.

2. To restrict the selection of geographical locations to a particular geographical 
level, then: 

a. Make a selection from the Level drop-down list.   

b. Click Go to the right of the Name field.

The list of locations is restricted to the geographical level selected.

3. To search for a geographical location:

a. In the Name field at the top of the window, enter a name or a partial name. 
Use the% to substitute for missing letters.   
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b. Click Go to the right of the Name field.

A list of found locations appears.

4. If you wish to add all geographical locations displayed in the window then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The locations are added to the list on the Advanced Search window.

c. If more then one page of locations displays, then click Next and repeat the 
same procedure.

5. If you wish to add only selected geographical locations, then:

a.  Select the check box next to each.

b. Click Add.

The locations are added to the list on the Advanced Search window.

c. If more than one page of locations displays, then click Next to view the next 
page and repeat this procedure.

6. When finished selecting geographical locations, click Close.

Entering Product Search Criteria
Use this procedure to enter one or more products or product families as search 
criteria in the advanced search.

Prerequisites
None

Note: If more than one page of locations displays, you must add 
each page separately. The Select All button selects only those 
locations visible on a page at one time.

Note: If more than one page of locations displays, you must add 
locations on each page separately. A location you select on a page 
does not remain selected when you view another page.
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Steps
1. Navigate to the Product Locator window. Open it from the Product region of 

Advanced Search by clicking Add.

2. Select add products or add product families: 

a. From the Type drop-down, list select Product or Product Family.   

b. Click Go to the right of the Name field.

The window displays the list of products or product families depending on 
your selection.

3. To search for a products or product families, then:

a. In the Name field at the top of the window, enter a name or a partial name. 
Use the % character to substitute for missing letters.   

b. Click Go to the right of the Name field.

The window displays the list of products or product families.

4. To add all products or product families displayed in the window then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The products or product families are added to the list on the Advanced 
Search window.

c. If more then one page of product or product families displays, then click 
Next and repeat the same procedure.

5. If you wish to add only selected products or product families, then:

a. Select the check box next to each.

b. Click Add.

The products or product families are added to the list on the Advanced 
Search window.

Note: If more than one page of product families displays, you 
must add each page separately. The Select All button selects only 
those products or product families visible on a page at one time.
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c. If more than one page of locations displays, then click Next to view the next 
page and repeat this procedure.

6. When finished, click Close.

Entering Deliverable Search Criteria
Use this procedure to enter one or more deliverables as search criteria in the 
advanced search.

Prerequisites
None

Steps
1. Navigate to the Deliverable Locator page. Open it from the Deliverable section 

of Advanced Search by clicking Add.

2. Select deliverable and: 

a. Enter its name or a partial name into the Name field. You can use the % to 
substitute for missing letters. 

b. Click Go.

The page displays the list of found deliverables.

3. To add all deliverables displayed in the window as search criteria:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

All the deliverables on the page are added to the list on the Advanced 
Search window.

c. If more then one page of deliverables displays, then click Next and repeat 
the same procedure.

Note: If more than one page of products or product families 
displays, locations on each page separately. A product or product 
family you select on a page does not remain selected when another 
page is viewed.
118 Oracle Marketing Online Concepts and Procedures



Searching
4. To add only selected deliverables, then:

a.  Select the check box next to each.

b. Click Add.

The deliverables are added to the list on the Advanced Search window.

c. If more than one page of deliverables displays, then click Next to view the 
next page and repeat this procedure.

5. When you are done, click Close.

Entering Partner Search Criteria
Use this procedure to enter one or more partners as search criteria in the advanced 
search.

Prerequisites
None

Steps
1. Navigate to the Partner Locator window. Open it from the Partner region of 

Advanced Search by clicking Add.

2. To search for a partner: 

a. Enter the name or partial name into the Name field. Use % to substitute for 
missing letters. 

b. Click Go.

The page displays the list of found partners.

Note: If more than one page of deliverables displays, you must 
add each page separately. The Select All button selects only those 
deliverables visible on a page at one time.

Note: If more than one page of deliverables displays, you must 
add locations on each page separately. A deliverable you select on a 
page does not remain selected when you view another page.
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3. To add all partners displayed in the window as search criteria:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The partners are added to the list on the Advanced Search window.

c. If more then one page of partners displays, then click Next and repeat the 
same procedure.

4. If you wish to add only selected partners, then:

a.  Select the check box next to each.

b. Click Add.

The partners are added to the list on the Advanced Search window.

c. If more than one page of partners displays, then click Next to view the next 
page and repeat the procedure.

5. Click Close.

Entering Message Search Criteria 
Use this procedure to enter one or more messages as search criteria in the advanced 
search.

Prerequisites
None

Steps
1. Navigate to the Message Locator page. Open it from the Message section of 

Advanced Search by clicking Add.

Note: If more than one page of partners displays, you must add 
each page separately. The Select All button selects only those 
partners visible on a page at one time.

Note: If more than one page of partners displays, add locations on 
each page separately.
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2. To search for a message:

a. Enter its name or partial name into the Name field. Use % to substitute for 
missing letters. 

b. Click Go.

The page displays the list of found messages.

3. To add all messages displayed in the window as search criteria:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The messages are added to the list on the Advanced Search window.

c. If more then one page of messages displays, then click Next and repeat the 
same procedure.

4. To add only selected messages, then:

a.  Select the check box next to each.

b. Click Add.

The messages are added to the list on the Advanced Search window.

c. If more than one page of messages displays, then click Next to view the 
next page and repeat this procedure.

5. When finished, click Close.

Entering Workbook Search Criteria
Use this procedure to enter one or more workbooks as search criteria in the 
advanced search.

Prerequisites
None

Note: Each page of messages must be added separately. The Select 
All button selects only those messages visible on a page at time.
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Steps
1. Navigate to the Workbook Locator page. Open it from the Workbook region of 

Advanced Search by clicking Add.

2. To search for a workbook: 

a. Enter its name or a partial name into the Name field. Use % to substitute for 
missing letters. 

b. Click Go.

The window displays the list of found workbooks.

3. To add all workbooks displayed in the window as search criteria, then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The workbooks are added to the list on the Advanced Search window.

c. If more then one page of workbooks displays, then click Next and repeat 
the same procedure.

4. To add only selected workbooks:

a.  Select the check box next to each.

b. Click Add.

The workbooks are added to the list on the Advanced Search window.

c. If more than one page of workbooks displays, then click Next to view the 
next page and repeat this procedure.

5. When you are done, click Close.

Entering List Search Criteria
Use this procedure to enter one or more lists as search criteria in the advanced 
search.

Note: Each page of workbooks must be added separately. The 
Select All button selects only workbooks visible on a page at a time.
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Prerequisites
None

Steps
1. Navigate to the List Locator window. Open it from the List region of Advanced 

Search by clicking Add.

2. To search for a list: 

a. Enter its name or a partial name into the Name field. Use % to substitute for 
missing letters. 

b. Click Go.

The window displays the list of found lists.

3. To add all lists displayed in the window as search criteria, then:

a. Select the Select All check box at the bottom of the list.

b. Click Add.

The lists are added to the list on the Advanced Search window.

c. If more then one page of lists displays, then click Next and repeat the same 
procedure.

4. To add only selected lists, then:

a.  Select the check box next to each.

b. Click Add.

The lists are added to the list on the Advanced Search window.

c. If more than one page of lists displays, then click Next to view the next 
page and repeat this procedure.

5. When finished, click Close.

Note: Each page of lists must be added separately. The Select All 
button selects only lists visible on a page at a time.
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The List of Values (LOV)
This topic explains how to use list of values (LOV) fields in the application. These 
are fields with a Go button located to the right of the field. 

Prerequisites
None

Steps
1. If a partial search string is known:

a. Enter the characters to search for in the field. 

Use use the percent symbol to substitute for any characters. For example, 
entering ca% searches for all of the objects starting with the letters ca. 
Entering %ca, searches for all of the objects ending with the letters ca. 
Searching for c%a searches for any string of characters beginning with c 
and ending with a.

b. Click Go.

The list of values window opens, displaying the results of your search.

2. If the search returns multiple pages of results, use the First, Previous, Next, and 
Last buttons to navigate through the results.

3. To repeat your search with modified search criteria, then:

a. Enter the new search string in the Search Keyword field.

b. Click Search.

4. To select value from a list and enter it into the field, click on the value which 
appears as a link.

5. To cancel out of a list of values, click Cancel.

Note: Search speed is increased by supplying the beginning or the 
end of a sequence of characters. For example, searching for 
%results is faster than a searching for %results%. A search for 
Q1% is faster than a search for %Q1%.
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Troubleshooting

System Error: You have been signed out automatically.
If you receive this error:

1. Clear the cache of your browser following instructions that come with your 
browser.

2. Close all browser windows. If using Netscape, this includes email messages.

3. Restart the browser.

4. Log into Oracle Marketing Online.
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Setting Up Marketing Mediums for Campaigns
Administering Oracle Marketing Online

This group of topics explains how to administer different functions of Oracle 
Marketing Online. Depending on your implementation, these procedures may be 
restricted to applications administrators only.

Enabling Campaign and Event Approval Workflow
Use this procedure to enable the Workflow approval process for campaign themes 
and budgets. You must enable the Workflow for each campaign and event setup 
separately.

Prerequisites
You must create campaign setups first. 

Steps
1. Navigate to Administration > Setup > Custom Setup.

2. Click on the name of the setup you wish to enable.

The Custom Setup subtab appears.

3. If you wish to enable campaign theme approval using the default Oracle 
Marketing Online Workflow, then select the Show check box for Theme 
Approval. This is one of the last items on the list.

4. If you wish to enable campaign budget approval using the default Oracle 
Marketing Online Workflow, then select the Show check box for Budget 
Approval. This is one of the last items on the list.

5. Click Update.

Setting Up Marketing Mediums for Campaigns
Use this procedure to create or edit marketing mediums you use to execute the 
marketing activities for your company. A marketing medium can be a magazine or 
a television station you advertise in, an email server that sends out email 
promotions, or a telemarketing center. A marketing medium can have only one 
marketing activity associated with it at one time.
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Prerequisites
Optional entry in Preferred Vendor, Party, and Managed By fields requires setup in 
Oracle financial applications.

Steps
1. Navigate to Administration > General > Marketing Medium.

2. If you are creating a new entry, then click Create. Otherwise select the name of 
the marketing medium you wish to edit.

The Create Marketing Medium or Marketing Medium Detail subtab appears.

3. Enter or edit the name for the marketing medium.

4. Optionally, enter the other fields. The list of values for Preferred Vendor, Party, 
and Managed by come from ERP setups.

5. If you have not yet set up activities, then leave the Activity field blank. You can 
associate marketing mediums to activities while creating activities.

6. Click Create or Update.

You are now ready to set up activities.

Guidelines
The optional fields include:

Field Name Description

Preferred Vendor Company name set up in Oracle Accounts Payable

Managed By Individual name set up in Oracle Human Resources

Party Party from the Oracle Customer Model

Active From and Active 
To 

Dates this marketing medium can be used

Internal, Outbound, and 
Inbound check boxes

Specifies which type of campaigns the marketing medium can 
be used for 

Activity Lets you assign a marketing medium to an activity. If you have 
not yet created your activities, then leave this field blank. 
Instead, do the assignment while creating your activities. 

Description Free text description
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Setting Up or Editing Activities for Campaigns and Events
Use this procedure to set up the activities for your campaigns and events. Each 
activity must be associated with one or more marketing mediums through which it 
is carried out. 

For example, if you are running print ads in two newspapers, the Wall Street 
Journal and the Washington Post, and broadcasting a spot on one television station, 
then you may want to create two separate activities, one named "Print Advertising" 
and another named "Television Advertising". You associate the Print Advertising 
activity with two marketing mediums: The Wall Street Journal and the Washington 
Post. You associate the Television Advertising activity with the television marketing 
medium.

Prerequisites
You must set up marketing mediums before you can complete this procedure.

Steps
1. Navigate to Administration > Setup > Activity

2. If you are creating a new activity, then click Create.

3. If you are editing an existing activity, then select the name of the activity you 
wish to edit.

The Create Activity or Activity Details subtab appears, depending on whether 
you are creating or editing the activity.

4. Enter or modify the name of the activity. This activity name appears in the 
Activity drop-down list in campaigns and events.

5. Use the Activity Type list of values (LOV) to select an activity type for this 
activity. The activity appears in the Activity list of values, when users select this 
activity type only.

6. Select the Active check box.

7. Enter a description.

8. In the Marketing Mediums region, enter one or more media that can be used for 
this activity:

a. Use the Name drop-down list to select the marketing medium.
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b. In Active From and Active To fields enter the date range for this activity. 
The dates must fall between the effective dates for the marketing medium 
you have chosen. 

9. Click Create or Update.

Guidelines
The optional fields include:

Creating Custom Setups for Campaigns and Events
Use this procedure to create custom setups that customize what information users 
must enter for campaigns and events. A custom setup specifies:

■ Which checklist attributes appear during campaign and event creation

■ Which of these must be filled in by users before they can make a campaign or 
an event active

■ The order in which the attributes are listed in the checklist

When users create campaigns and events, they select one of the custom setups you 
create using the Setup Type drop-down list. 

Prerequisites
Before you carry out this procedure, you must set up:

■ Marketing mediums

■ Activities

Steps
1. Navigate to Administration > Setup > Custom Setup.

2. Click Create.

Field Name Description

Active, Response check 
boxes

Lets you classify if an Activity is related to outbound or inbound 
marketing activities.

Description Free text.

Marketing Medium 
Name

List of values with the marketing mediums you have set up 
previously.
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The Create Custom Setup subtab appears.

3. In Setup Name, enter a name for this custom setup. This is the name that 
appears in the Setup Type drop-down list during campaign and event creation 
and above the list of checklist attributes.

4. From the Associated With drop-down list, select whether you want to use this 
template for execution campaigns, rollup campaigns, execution events, or 
rollup events.

5. Use the Activity Type drop-down list to select an activity where this custom 
setup will appear. 

6. If you wish to limit the use of this custom setup further, then select an activity 
for the activity type. If you do not select an activity type, then this custom setup 
can be used for all activities for the activity type.

7. In the Components region, select the Show check box for attributes you wish to 
appear on the checklist for the campaign or event using this custom setup.

8. If you wish to make any of the attributes mandatory for a campaign, then select 
the Mandatory check box next to each attribute. If a user does not make an 
entry in a mandatory attribute of a campaign, then the campaign cannot be 
used.

9. If you wish to modify the order in which the attributes appear on the checklist 
then modify the numbering in the Sequence field.

10. If you wish to enable campaign theme approval using the default Oracle 
Marketing Online Workflow, then select the Show check box for Theme 
Approval. 

11. If you wish to enable campaign budget approval using the default Oracle 
Marketing Online Workflow, then select the Show check box for Budget 
Approval. 

12. Click Create.

Note: Making a checklist attribute mandatory requires users to 
make an entry in the attribute but does not require them to fill in all 
the information requested. Any entry satisfies the requirement and 
marks the attribute with a check mark. 
Administering Oracle Marketing Online 131



Creating Metrics
Guidelines
The optional fields include:

Creating Metrics
Use this procedure to set up all metrics. This includes cost metrics as well as those 
metrics used to track the performance of your campaigns, events, and deliverables.

Prerequisites
None

Steps
1. Navigate to Administration > General > Metric.

2. If you wish to create a new metric, then click Create.

3. If you wish to edit an existing metric, then select the metric to edit from the list. 

The Metrics Definition subtab appears.

4. Enter the metric name.

5. Optionally, select the metric category and subcategory.

6. From the Used With drop-down list, select what object uses this metric.

7. Enter an optional description.

8. In the Calculation region, select the radio button that describes how this metric 
is getting its values:

Field Name Description

Active check box Deselecting this check box removes this template from use.

Source Code Suffix Enter a suffix for the source code that is generated automatically 
whenever an agent creates a campaign.

This source code becomes the primary reference to the campaign 
and is referred to by the Oracle Telesales and Oracle Order 
Capture applications. It can be used to track the effectiveness of 
a campaign through consumer activity. When a campaign is 
defined, a source code may be manually entered by the user, or 
generated by the system automatically.

Marketing Medium 
Name 

LOV of Marketing Mediums you have set up previously.
132 Oracle Marketing Online Concepts and Procedures



Creating Venues
■ If users are entering values in this metric, then select the Enter Value 
Manually.

■ If this metric is getting its values from another metric then select Accrue 
through summarization. Use this selection both for metrics that summarize 
other metrics at the same level in the campaign or event hierarchy and 
those that summarize values from levels down the campaign or event 
hierarchy.

■ If the metric is to get its value using an external program, then select the 
Calculate using Program and enter the path in the text box provided.

■ If you wish the metric to be calculated using another metric, select 
Calculate using Metric, click Go and use the list of values (LOV) to enter 
the metric.

9. In the Summarize to region, enter information about where the metric is 
passing its values. Select one of the three radio buttons:

■ If the metric is not passing its value to another metric, then select None.

■ If the metric is passing its value to a metric in a parent rollup campaign or 
parent rollup event, then select of the Parent, click Go, and use the list of 
values (LOV) to enter the metric. The destination metric must be of type 
Accrue through summarization.

■ If this metric is sending its values to another metric at the same level in the 
campaign or event hierarchy, then select at same level, click Go, and use 
the LOV to enter the name of the metric to which you are passing data. 

10. Click Update.

Creating Venues 
Venues describe the physical location where an event is being held. Use this 
procedure to set up venues for your events.

Prerequisites
None

Steps
1. Navigate to Administration > General > Venue

2. Click Create.
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The Create Venue subtab appears.

3. Enter the venue name, venue type, and other appropriate information about the 
venue.

4. Select the Active check box.

5. Click Create.

Guidelines
Make sure to use a unique name to identify a venue. For example, the name Hyatt 
Regency covers hotels in many locations. Use Hyatt Regency San Francisco instead.
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